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Features

TrueCafe is a distributed system. It consists of server and client software.
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Server software is a center of cyber cafe maintenance. It provides pricing, customer and session

management, payments, reporting and so on.

Client software blocks unauthorized access to terminals, displays statistics of a user's session and a list
of applications a user can start after a terminal is unlocked.

Control a cyber cafe with ease

Utilize pre-paid tickets (time codes)

Provide Wi-Fi hotspot support (wireless billing)

Use license key (CD-key) management

Install on NComputing and Terminal Server

Automatically charge a customer for printing

Setup any complicated pricing

Protect terminals

Control terminals remotely

Chat with a customer

Manage terminals

Setup a point-of-sale

Use inventory system

Game console billing

Save power in your cyber cafe

Calculate Internet traffic and browse URL log
Limit Internet bandwidth



http://www.truecafe.net/

Use shifts to control your operators

Analyze the business data

Get online/email reports (Web Reports)

Backup your data and settings

Web Access

Control a cyber cafe with ease

All important information is displayed on one screen: the list of customers that you can create, edit, sell
products to, drag-n-drop them on a terminal to start a session; the list/icons of workstaions you can
arrange according to the real location of terminals in the club; session summary for a selected terminal;
the list of active sessions. While managing a session, you can set/extend a time limit or pre-paid, add
any product (printing, scanning, etc.), give a discount, print a receipt when a session is finished.

Read more

Utilize pre-paid tickets (time codes)

Create, print, sell, delete or recover pre-paid tickets. Distribute tickets among your employees (agents).
Keep track of a ticket status. Delete all unused tickets. Use a ticket to top-up a customer session.
Create promotional tickets.

Create tickets which your customer can only use on either Wi-Fi terminals or desktop PCs. This is useful
when you provide different charge rates for Wi-Fi and dekstop sessions.

Read more

Provide Wi-Fi hotspot support
(wireless billing)

Charge the customers of your cafe, club, shop, hotel, etc. when they connect their laptops, PDAs or any
other mobile devices to your access point (Wi-Fi hotspot) and use the Internet to surf the web, read
emails or chat via an instant messenger. Customize your Wi-Fi billing login and session info pages (show
your cafe logo, etc.). Use white list feature to specify Wi-Fi billing exceptions.

Read more

Use license key (CD-key) management

Cut down your game licensing expenses using the CD-key management system. Purchase a quantity of
licenses to cover a simultaneous gameplay vs. purchasing a license for every terminal where a game is
installed. Valve Steam accounts integration is supported.

Read more

Install on NComputing and Terminal
Server

Install TrueCafe on a multi-session platform such as NComputing host (www.ncomputing.com) or

Windows Terminal Server. In this case a number of user sessions run on a host computer
simultaneously. Each session is considered by TrueCafe as a separate virtual terminal with TrueCafe
Client running. TrueCafe Server can be installed on either the same shared computer or a detached


http://www.ncomputing.com/

one.

Read more

Automatically charge a customer for
printing

TrueCafe Printer Watcher software let you automatically charge a customer for printing on any printer in
your cyber cafe, using a very precise method of calculating the exact number of document pages and
copies. Use the print confirmation feature which notifies your customers how many pages they print and
how much they are charged for the printing. You can also turn on the print control feature which means
a customer can only print if he has enough money on his balance.

Read more

Setup any complicated pricing

Maybe the most flexible and convenient pricing setup you have ever seen. Configure pricing per minute,
hour, an item or setup a table of fixed sums that are added to a bill; round amount of a service; setup
taxing (included in or excluded of the price). Create a number of time zones with distinct pricing for
each one. Setup amount-dependent pricing (e.g. 1 hour = $5, 2 hours = $7, etc.). Create service
packages for each type of customers you have (standard customers, students, employees, VIP, etc.).
Assign a package to a customer or select one while starting a session. Let your customers select pricing
they prefer by providing them with "public" packages. Define a system of discounts that you can use
from time to time.

Read more

Protect terminals

TrueCafe Client software locks a terminal until a customer logins to the system using his
name/password or a cyber cafe administrator unlocks a terminal remotely. TrueCafe Client can be
configured to auto-start when a computer starts, disable the Task Manager, hide the standard Desktop
and Start Menu. You can setup a restricted set of applications a user can start from the TrueCafe Client
(e.g. computer games). Also, TrueCafe Client displays session statistics (time, total sum, etc.) and
allows a user to end his session. A user is warned via a message or custom sound file when critical
amount of time/money is left. A user can order services/products such as drinks, snacks, etc. from
his/her place. Restart a terminal when a session ends to rollback any changes made by a customer
(providing that DeepFreeze software is installed). TrueCafe Server monitors every computer in a cyber
cafe, keeps track of computers' state and saves changes into a system log.

Read more

Control terminals remotely

Get a terminal screenshot and the list of running processes. Terminate any process, start an application
remotely. Control terminal sound volume, mute sound. Monitor your Internet cafe terminals state and
get a notification when a terminal is off or TrueCafe Client is not running.

Read more

Chat with a customer


http://www.truecafe.net/deepfreeze.html

Use a build-in instant messenger to organize a chat between operator and a customer on any terminal.
Send a text message to a terminal in order to notify your customers about an important event or
provide them with any other information.

Read more

Manage terminals

Setup a terminal profile for any type of terminal (e.g. Internet station, game station, etc.). A terminal
profile is a set of applications (the name and path on the disk) which are displayed in the TrueCafe
Client and can be started by a user. You can remotely shutdown or restart any terminal, start any
application on a remote terminal (enter the path on the disk or choose the application from a pre-
defined list). Also, you can remotely change the TrueCafe Client security level (none, auto-start, disable
Task Manager, hide Desktop and Start Menu).

Read more

Setup a point-of-sale

Sell products in your cyber cafe. Make a walk-in (guest) and member sales, select multiple items into a
bill, add/remove items from a bill. Print a receipt on the receipt printer or any other printer. Make your
unique receipt design.

Read more

Use inventory system

Control available amount of your items in the stock. Use your barcode scanner when you sell the items.

Read more

Game console billing

Use TrueCafe with your game consoles such as XBox, PlayStation, etc. (X10 modules are required).

Read more

Save power in your cyber cafe

Shutdown idle or all terminals by one click. Shutdown an idle terminal automatically after a few minutes
of inactivity. Turn on a terminal remotely before starting a customer session.

Read more

Calculate Internet traffic and browse
URL log

TrueCafe calculates amount of Intenet traffic for a user's session. You can use this simultaneously with
your current Windows or Linux Internet (proxy) server. The cost of internal cyber cafe traffic is not
included into a user's bill. You can change incoming/outgoing traffic coefficients, configure the list of
ports that are used for filtering or setup any complicated traffic filter. URL log: keep track of the Internet
websites and pages which a customer opens on your cyber cafe terminal.



Read more

Limit Internet bandwidth

You can specify some Internet bandwidth usage limit for every customer terminal. Depending on a
pricing package, a bandwidth limit can be 64, 96, 128, etc. kbps or unlimited.

Read more

Use shifts to control your operators

Control your operators and cash flow using the shift management feature.

Every operator computer is considered as a cash desk so that each shift is linked to the corresponding
cash desk. When an operator starts working with the program collecting any payment, starting/stopping
customer sessions, etc., he has to start a shift. When he finishes working with the software, he stops his
shift.

Read more

Analyze the business data

Use TrueCafe Reports to analyze your business data: the list of customers detailed by sessions and
services provided; the list of services detailed by customers; the list of sessions; the list of system
events (changes in the state of computers, the start/stop of the server, etc.).

Read more

Get online/email reports (Web
Reports)

Analyze your business data in your web browser. Get access to your cyber cafe activity information
outside the cafe from the Internet. Browse session, customer, service, terminal, etc. data for any period
of time. View the diagrams which represent your business growth. Print any report on your printer for
further analisis. Receive your Internet cafe reports automatically by email every day, every Monday or
every 1st day of month.

Read more

Backup your data and settings

Backup and restore TrueCafe database and all system files. Configure a backup schedule to backup
your data and settings automatically. Clean up the database.

Read more

Web Access

Sell tickets and top-up customer accounts remotely from your web browser. This is useful when you
have an operator who sells tickets/tops up accounts from a separate computer (e.g. hotel reception)
and doesn't have access to your TrueCafe Server computer.



Club map feature: setup the info display at your shop or cafe receiption so that an incoming customer
can locate an available terminal himself.

Read more



System Requirements

Operating system:

= Windows XP

m Windows Vista

= Windows 7

m Windows 2003 Server
= Windows 2008 Server

Server requirements:

m Processor: Intel Pentium 100 MHz or higher (P4 is recommended)

m Memory: minimum 32 MB of RAM (512 MB is recommended)

m Disk usage: 10 MB of hard disk space + about 30 MB space for database is recommended
m Video: VGA or higher resolution monitor

m Mouse is required
Client requirements:

m Processor: Intel Pentium 100 MHz or higher (P14 is recommended)
m Memory: minimum 32 MB of RAM
m Disk usage: about 2 MB of hard disk space

It is recommended to install Microsoft Data Access Components (MDAC) version 2.7 or later versions.
Otherwise, the database upgrade might not work properly. MDAC is available for downloading from

Microsoft web site:

Download MDAC 2.8



http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c&DisplayLang=en

History
Version 4.6 (Apr 2011)

Key new features:

m Advertisement

m Print options screen

m Exportto CSV

m Custom ticket layout

m Wi-Fi/Desktop customers
m Cut tickets

m Terminal security
Minor improvements:

m Print monitor: correct copies number calculation

m New operator access options: top-up customer accounts, start/extend sessions
m No need to restart server any more when new tickets created

m "Run as Administrator" not required to register the software

m Sell items: fractional quantities

m Daily report. An operator only sees his/her sales

m WebReports. Printer friendly pages

m Options value field size increased

m Program error reports by email
Bugs fixed:

m TrueCafe Client sometimes doesn't lock the terminal screen

m "List index..." error when adding inventories

Version 4.5 (Jul 2010)

Key new features:

m Web Access

m Web Reports by email

m Ping monitor

m Scan customer documents

m Club map

m Session rounding

m Ticket printer

m Auto-login when Windows login = TrueCafe login
m Lock screen when disconnected

m Web Reports: Payload report



Minor improvements:

m Tickets are available on the expiry date and disabled the next day
m Ticket expiry date "today": sale/login date + 0 days

m Auto-close pre-paid sessions stopped from the server side

m Security options: change time/money and paid amounts

m TrueCafe Client. Press Shift when you double click on a program icon to start it via "Run as...
(administrator)"

m Log outs list performance improvement
m  Wi-Fi billing: proxy 8080 and 3128 ports are supported
m Copy application profiles

m Web Reports. URL log

Bugs fixed:

Network driver can't be installed on Windows Vista/7/2008 64-bit versions

m TrueCafe Client session window doesn't show up sometimes

m  Wi-Fi billing traffic counter resets when the info page refreshes

m Ticket login mask isn't applied to "login = ID" tickets

m Incorrect 1-minute rounding

m "User not found" error when customer types extra spaces before/after login

m Program registration on Windows 7 and Vista

m Duplicated Wi-Fi sessions when a terminal IP is changed

m Incorrect pre-paid amount starting a session for a terminal with the pricing coeff more than 1

m Printing tickets on some receipt printer models ("division by zero" error)

Version 4.4 (Jul 2009)

Key new features:

m Bandwidth management

m Valve Steam support

m Wi-Fi white list

m Wi-Fi/Desktop tickets

m Close programs delay

m Top-up and ticket receipts

Minor improvements:

Auto connect terminals with TrueCafe Client installed, which haven't been added on the server
side

m Options. Change currency sign
m Start session window. Select customer
m Logouts list (instead of open sessions list)

m Client. Locate TrueCafe Server



m Client. Prevent starting a few Clients under the same Windows user account
m Client. Network communication improvements

m CD-Key management. Don't run program when no license available

m Taxes. All prices and amounts include taxes

m Receipt. Sale date section

m Client. Reconnect to server (button)

m Separate network channel for terminal data (screenshots / process list / etc.)
m Performance improvements

m Sales. Allow negative quantity

m Don't ask the password starting a session from the server side (option)

m Ticket top-up. Display customer as transaction owner

m Tickets recover: administrator only

m  Wi-Fi. Display full redirect (domain + document + params) on the status page
m Sale window. Display prices + tax

m Sales report. Display shift operator

m Rename main menu > View > Shift report -> Daily report

m Client. Windows user name on the login window caption

m Discount column in Web Reports, Sales report and Daily report

m Hide private pricing packages on the customer window from non-Admin users
m Display pricing package ID (main menu > Setup > Pricing)

m Session & New session windows. Display terminal name in caption

m Auto-close sessions option: any pre-paid by default

Bugs fixed:

m Move session applies minimal charge more than once

m Add time/money doesn't work well with decreasing pricing table

m Server doesn't delete a wi-fi terminal when a session ends

m Shift end_fact becomes NULL. Causes startup exception

m Chat doesn't work well with dynamic IP terminals

m Pause session doesn't work well with post-paid time limited sessions
m URL log. URLs with more than 1024 characters corrupt the database

m Client. Program shortcuts mix up when a few shortcuts have the same CD-key group (useful for
Steam applaunch)

m Client. Vista. Session info window isn't displayed sometimes

m Client. Default app icon is not displayed on Vista

m Client. Display "search path" programs icons (e.g. calc.exe, notepad.exe)
m Client. Connection lost switching unlock > lock

m Thin client terminals screenshots mix-up

m Start/stop session sometimes fails when using remote screenshot

m Setup fails on 64-bit Windows versions

m Setup doesn't add firewalls exceptions on Vista

m Vista. Restart server doesn't work



Version 4.3 (Sep 2008)

m Shift management

m Customer programs

m TrueCafe Client connection wizard

m  Wi-Fi session timeout

m Create promotional tickets

m Get original website redirect link on the Wi-Fi login page
m Sales report

m View customer sessions from the customer window

m Security. Hide logical drives on your terminals

m Clean-up. Delete sales data

m Select data folder when you install TrueCafe

m Scripts. Run external programs when TrueCafe Client logs on/off

Version 4.2 (Apr 2008)

Wi-Fi hotspot support (wireless billing)

m Terminal-dependent pricing

m Ticket pricing wizard

m Refunds

m TrueCafe Client continues a session when terminal starts
m Enable/disable TrueCafe Client buttons

m Minimize TrueCafe Client session window

m Time left warnings on the server side

m Terminal screenshot security

Version 4.1 (Nov 2007)

m Inventory

m TrueCafe Client security

m Printing confirmation

m Ticket expiry date: fixed, sale + X days, login + X days
m Ticket login mask
m Terminal max sound volume

m Keyboard shortcuts

m Windows Vista support

Version 4.0 (Jun 2007)

License key (CD-key) management

m NComputing and Terminal Server support: use TrueCafe on thin-client platforms

Web Reports: analyze your cyber cafe business data in your web browser

Instant Messenger: chat with a customer and send notification messages to a terminal




m URL Log: keep track of the Internet websites and pages a customer opens on a terminal
m Printer Watcher: block printing if not enough money left on a customer balance

m Customer: assign a customer photo

m Customer: credit limit

m Administrator: pause/resume a customer session

m Tickets: password options (length, numbers, letters)

m Printer Watcher: session ID, print job status in log

m Terminals: dynamic IP (DHCP) support

m Sessions: session list, re-print a receipt

m Database Cleanup: delete unused records of print, CD-key reservation or URL log

m Restart a terminal when a session ends

Version 3.2 (Nov 2006)

m Administrator: remote terminal screenshot, task manager, volume control

m Administrator: ticket face value in the customer/ticket list

m Administrator: terminal ping status in the list

m TrueCafe Client: log off a customer session when a screensaver starts

m TrueCafe Client: log off a customer session when Windows logoff/shutdown
m TrueCafe Client: clear Internet Explorer History and Temporary Internet Files when log off
m TrueCafe Client: connect/disconnect a dial-up connection when logon/logoff
m TrueCafe Client: protect options with an unlocking code in registered version
m Tickets: expiration date

m Printer Watcher: distinct charge rates for monochrome and colour printing

m Printer Watcher: extended terminal match: name -> ip -> name in LAN

m Power Management: shutdown idle or all terminals in your cyber cafe, turn on a terminal

remotely, automatically shutdown an idle terminal
m Point-of-sale: check the customer balance before making a sale
m Pricing: minimal charge, calculation improvements
m Customer: user access improvements
m Customer: highlight an account in the list with a background colour

m Database Workshop: backup schedule

m Cash and credit card payments accepted

m Set default ticket name in options

m Disable simultaneous login for any customer/ticket
m Receipt: customer name section is added

m Setup: add TrueCafe Windows Firewall exceptions
m Language Editor is disabled in TrueCafe Client

m Precise terminal icons movement

Version 3.1 (Aug 2006)

m Tickets (time codes)




m Point-of-sale: walk-in and member sales

m TrueCafe Client: a customer can top-up his balance

m TrueCafe Client: a customer can change his password
m TrueCafe Client: perfect terminal locking

m TrueCafe Client: set a background picture

m TrueCafe Client: end running applications

m Sessions: close sessions automatically

m Sessions: pre-paid and post-paid sessions

m Customer: specify pre-paid or post-paid method explicitly
m Customer: calculate pre-paid account time left

m Customer: top-up a balance

m Customer: virtual cash

m Daily report

m Interface improvements: XP-styled icons

m "Switch user" in main menu

m Session list: customer age is displayed

Version 3.0 (Mar 2006)

m Sessions: pre-paid and timers improvements
m Pricing improvements. Time zones, rounding, taxing, etc.

m Traffic calculation

m POS. Receipt printing: Customized receipt (fonts, graphics, etc.)

m Printer Watcher: automatically charge customers for printing

m TrueCafe Client: order services/products remotely

m TrueCafe Client: warn a customer when minimal time/money is left
m TrueCafe Client: (demo version), unlock password (closetruecafe)
m Main window interface improvements

m Session summary: time, taxes, totals

m Time/money left columns in the terminal list

m Active sessions in the session list are highlighted

m Move a customer from one terminal to another

m Session dialog is displayed when session is stopped

m Setup Wizard: helps you to configure TrueCafe at the first time

m Database Workshop: system backup/restore

m TrueCafe Server Manager is displayed if server is not running

Version 2.2 (Jul 2005)

m Terminal remote shutdown, restart, application start

m Terminal profiles, application management

m TrueCafe Client: the application list

m TrueCafe Client: security levels. Auto-start, disable Task Manager, hide Desktop and Start Menu.



m "Snap to grid" when arranging terminals

Version 2.1 (Apr 2005)

m New XP-styled interface

m Pricing: public & private services

m Pricing: discount for service packages
m Pricing: service packages order

m Pricing: services initial values

m language Editor

m Database Workshop



Technical support

We provide full technical support on TrueCafe. If you have any questions, suggestions or comments on
the system, please contact us by e-mail:

support@truecafe.net

For latest news and downloads related to our products please visit our website:

http://www.truecafe.net

Post your feedbacks to our forum:

http://www.truecafe.net/forum/

Contact us via MSN or Yahoo Messenger:

support@truecafe.net

Read TrueCafe RSS feed:

http://www.truecafe.net/rss.xml



mailto:support@truecafe.net
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mailto:support@truecafe.net
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Licensing

Demo version of TrueCafe allows to work with 4 terminals maximum.

To purchase a registered version please visit the order page.



http://www.truecafe.net/order.html

Setup. Step-by-step Guide
1. Install Server

Run TrueCafe installation program on your server/operator computer. Select the Server option to

install the server components:

i Setup - TrueCafe E“E||

Select Components
Which components should be installed?

Select the components wou want toinstall; clear the components you do not want ko
ingtall. Click Mest when pou are ready to continue.

Full inztallation b
Server, Administrator, Feports 7.4 B
L Frnker % atcher [install b on a compuker withr a pnnter ta charge pnnbing| oMb
[] Client [locks a computer] 1.1 B

Current zelection requires at least 3.4 MEB of disk space.

[ < Back ]Emﬂ.ez-:b |[ Cancel

2. Run TrueCafe

Start TrueCafe: Windows Start > TrueCafe > TrueCafe

Use the default login/password = adm/adm:

Logon X
% Hame (adm |
password [+ |
language | Enlsh v |

Defaulk username/password are:
adm/adm

o ] [ coned |

3. Install Client

Run TrueCafe installation program on your terminal computer(s). Select the Client option to install the



client components:

it Setup - TrueCafe

Select Components
Which components should be installed?

Select the components pou want to inzstall; clear the components pou do not want to
inztall. Click Mest when you are ready to continue.

| Custom installation w
[] Server, Administrator, Feports 7.4 B
[ Printer ‘W atcher linstall it on 8 computer with & orinter bo charge orinting] .2 B
Client [locks a computer] 1.1 MB

Current zelection requires at least 1,7 MB of dizk space.

[ < Back ]ue:-:w |[ Cancel

4. Connect Client to Server

Run TrueCafe Client when the installation ends or restart your computer and TrueCafe Client will start
automatically. The first time it starts it displays the Connection wizard window:

Connection Wizard [$_<|

Connection wizard helps wou connect TrueCafe Client on this terminal to TrueCafe

Server, Ik will automatically add the terminal icon on the server side,

Server IP (IP address of the computer where TrueCafe Server is installed)
|192.168.0.1

Terminal bype
f* Stand-alone PC

™ Thin client kerminal, such as MCamputing, \Windows Terminal Server, ete,

This computer's IP address is
f* Static IP address

(" Dwnamic IP address

Terminal name (vou can change it on the TrueCafe Server side when added)
GATE

Mext Skip




Server IP: type IP address or host name of your server computer (a computer where TrueCafe Server
software is installed).

Terminal type: select whether it's a desktop PC or a thin-client terminal (NComputing, Windows

Terminal Service client, etc.)

Press the Next button and if you have specified your Server IP address correctly, TrueCafe adds the

terminal icon on your server side.

If you get Network error 10061, try disabling your firewalls on both server and terminal sides, or add

TrueCafeServer.exe program to your firewall exception list on the server side.

5. Login on Terminal

When you start your terminal computer, TrueCafe Client automatically starts, locks the terminal screen
and displays the login window:

TrueCafe 4.3.810.14 DEMO. Logon

Login |a|:|m

Password |***

Language |Eru;||i5h ﬂ
Optiuns — | ......... E nter .......... |

Use a customer login/password to start a session, e.g. your default administrative account -
login/password = adm/adm. TrueCafe Client unlocks the screen and displays the session info window:

= TrueCafe Client

Login SI'I'IIth
Marme Jobin Sriith
Pricing Employes
Payment Pre-paid
© Top-up Pre-paid 2.00
pr— Tirne 0:08 0.2z
Traffic 1]
@b Password. ., Others g
Surm 0.2z
Tax ]
o] ™ 0.22
Balance 1. 7 8
mne left: 0:18 |




If you need to unlock your terminal screen (close down TrueCafe Client program), you have to leave
login empty, type password = closetruecafe and press Enter.

What's next?

You could also create pre-paid tickets or setup your pricing or get to know more about

pre-paid and post-paid customer sessions



tickets

Setup. Step-by-step Guide
for Thin Clients

...such as NComputing (L130, L230, X300, etc.), Windows Terminal Server, etc.

1. Install Server

Run TrueCafe installation program on your server/operator computer. Select the Server option to

install the server components:

i Setup - TrueCafe [Z“@[‘&__(I

Select Components
Which components should be installed?

Select the components pou want to inzstall; clear the components pou do not want to
inztall. Click Mest when you are ready to continue.

Full inztallation hd
Server, Adminiztrator, Reports 7.4 B
L1 Frnter W atcher [inskall it on a computer with a pnnter to charge pnnbing e MbB
[] Client [locks a computer] 1.1 MB

Current zelection requires at least 8.4 MB of dizk space.

[ < Back ]ue:-:w |[ Cancel

2. Run TrueCafe

Start TrueCafe: Windows Start > TrueCafe > TrueCafe

Use the default login/password = adm/adm:

Logon E3
Q o |
passuord [+ |
lanquage | Englsh v |

Default username/password are:
adm/fadm

(04 l ’ Cancel




3. Install Client

Run TrueCafe installation program on your terminal host computer under administrative Windows

account. Select the Client option to install the client components:

it Setup - TrueCafe

Select Components
Which components should be installed?

Select the components pou want to inzstall; clear the components pou do not want to
inztall. Click Mest when you are ready to continue.

| Custom installation w
[] Server, Administrator, Feports 7.4 B
[ Printer ‘W atcher linstall it on 8 computer with & orinter bo charge orinting] .2 B
Client [locks a computer] 1.1 MB

Current zelection requires at least 1,7 MB of dizk space.

[ < Back ]ue:-:w |[ Cancel

4. Connect Client to Server

Run TrueCafe Client when the installation ends or restart your computer and TrueCafe Client will start

automatically. The first time it starts it displays the Connection wizard window:



Connection Wizard [5__<|

Connection wizard helps wou connect TrueCafe Client on this terminal to TrueCafe
Server, It will automatically add the terminal icon on the server side,

Server IP (IP address of the computer where TrueCafe Server is installed)
127.0.0.1

Terminal bvpe

" Stand-alone PC

I f* Thin client terminal, such as MComputing, Windows Terminal Server, etc.

This computer's IP address is
{# Static IP address

" Dwnamic IP address

Terminal name {vou can change it on the TrueCafe Server side when added)
A TE-Userl

Mext Skip

Server IP: type IP address or host name of your server computer (a computer where TrueCafe Server
software is installed). If you install TrueCafe Server and Client on the same host computer, you can use
Server IP = 127.0.0.1.

Terminal type: select thin-client terminal.

Press the Next button and if you have specified your Server IP address correctly, TrueCafe adds the
terminal icon on your server side.

If you get Network error 10061 , try disabling your firewalls on both server and terminal sides, or
add TrueCafeServer.exe program to your firewall exception list on the server side.

5. Login on Terminal

When you start your terminal computer, TrueCafe Client automatically starts, locks the terminal screen
and displays the login window:

TrueCafe 4.3.810.14 DEMO. Logon

Login |a|:|m
Password |***
Language |Eru;||i5h ﬂ

Options == |

Use a customer login/password to start a session, e.g. your default administrative account -



login/password = adm/adm. TrueCafe Client unlocks the screen and displays the session info window:

s TrueCafe Client E'
Login smi th

Marme Jobin Sriith

Pricing Employee

Payment Pre-paid

© Top-up Pre-paid 2.00
order. | Time 0:08 0.2z

Traffic 0
ﬂ Password. ., Others <
S 0.2z
Tax ]

Total D. 22
Balance 1. 7 8

mne left: 0:18 |

If you need to unlock your terminal screen (close down TrueCafe Client program), you have to leave
login empty, type password = closetruecafe and press Enter.

6. Optional: Unlock Server Screen

If you use your host computer for your administrator/operator, TrueCafe Client starts automatically
when the user logs on and locks the screen so that an operator has to close TrueCafe Client every time.
In order to stop TrueCafe Client from starting up automatically, you can apply a special registry file.
Please contact us in order to get this file.

What's next?

More about thin client support

You could also create pre-paid tickets or setup your pricing or get to know more about

pre-paid and post-paid customer sessions



mailto:support@truecafe.net
tickets

Known Issues
Windows XP

TrueCafe Client may conflict with your language settings. Please ensure that Windows Control Panel
> Regional Options> Text Services and Input Languages > Advanced > Extend support of advance text
services to all programs options is turned off:

Text Services and Input Languages

Settings | Advanced |

Compatibility Configuration

[_]Extend support of advanced text services to all programs

Select thiz check baw to turn on advanced test zervices in Motepad and
ather programs that do not normally support gpeech and handwriting
recognhition or other advanced input services,

Syztem Configuration
[ ] Tum off advanced text services

Select thiz check bowx to tumn off advanced test zervices in all programs.
Mot recommended for East Asian uzers becauze thiz clozes the
languane har.

F, ] [ Cancel

Skype

If you use TrueCafe Wi-Fi billing feature, it may conflict with Skype installed on your server. Open
Skype main menu > Tools > Options > Advanced > Connections , disable Use port 80... option, and

restart your server computer:



& Skype™ - Options

A General
ﬁ\‘h Privacy

v

P notifications

O cans

Chats & SMS

@ Advanced

m Bhranced Settings

‘@m

Connecthon: setup how Skype connects o the Intermet

Use park For incoming connections

[Juse peet 80 and 443 as akernatives For incoming conmections

[H] Horxeys

[] Mlowe Skype to modiy my firevall settings

|autamatic proxy detection %

[CIEnable proxy authentication

[Icisplay tecknicsl call info during calls
[ Cisplary Skeype bandwidth usage

ther things you can do

o Learn more about howe Skype deals with proxies and firewalls

[Sa'.la

J [ conce




Upgrade to New Version

In order to upgrade your current version of TrueCafe, uninstall your current version and install a new
one. You have to upgrade both server and client software.

When you uninstall TrueCafe, it doesn't delete you database and settings.

TrueCafe database is upgraded automatically by Database Workshop utility when the installation is over.
In case you get an error message upgrading the database, please download and install the latest
version of Microsoft Data Access components

If you upgrade from version 4.0 or earlier:

1) Stop all TrueCafe services: Windows Conrol Panel > Administrative tools > Services

2) Open your old TrueCafe data folder, usually ' C:\Program Files\TrueCafe

3) Open your new TrueCafe working folder: TrueCafe main menu > Tools > Data Folder

4) Copy (overwrite) backup and db folders and .ini files from your old TrueCafe folder into the new
one.

5) Run TrueCafe Database Workshop and update your database: Windows Start Menu > TrueCafe >
Database Workshop

6) Start all TrueCafe services: Windows Conrol Panel > Administrative tools > Services


http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c&DisplayLang=en
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Administrator Client
01. Terminals and Applications Reports
02. Pricing Web Reports
03. Customers Web Reports by Email
04. Tickets (Time Codes) Printer Watcher
05. Pre-Paid and Post-Paid Sessions Web Access
06. Shifts NComputing and Terminal Server Support
07. Point-of-Sale Wi-Fi Hotspot Support (Wireless Billing)
08. Inventory Valve Steam
09. Instant Messenger (Chat) Bandwidth Management
10. License Key Management Game Console Billing
11. Power Management Advertisement
12. Daily Report Database Cleanup
13. Sales Report Language Editor
14. Traffic Calculation and URL Log Database Workshop
15. Point-of-Sale. Receipt Server Manager
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Server Manager

TrueCafe Server Manager indicates whether TrueCafe Server is running and provides start/stop/restart
functions.

Closing Server Manger does not stop TrueCafe Server.

TrueCafe Server Manager E]::

|I| Setver skatus:
Running

Close

TrueCafe. Friendly Internet Cafe Software
Copyright © 1999-2011 TrueCafe, Ltd.
All rights reserved.
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Administrator

The main window contains:

® main menu and toolbar

m cyber cafe customer list (top left)

m system log (bottom left)

m terminal icons/list (center)

m terminal toolbar with the "arrange terminals" and "list" buttons, start/stop/timer/refresh buttons
m session summary for a selected terminal) (top right)

m terminal screenshot, process list, volume control, etc. (bottom center)

m customers' orders (bottom center)

m |log-outs (bottom right)

Terminal legend:

State Icon Meaning

Disabled You can't start a session on this computer
®

Free You can start a session on this computer
=

Occupied @ A session is started

Warning @ Minimal amount of time/money left



&0 Pevaes QO
["‘mw...][(}m-w...][gsd...] =3 5| (13 [Omumfw“ @M][@‘Raﬂm.l

0 |Login [z [estance | !
2 (anonymous) 0 @ g 1@ PN
| 0w Ticket 20,00 = -
111 Ticket 20,00 Termingl 1 Terminal 2 Terminal 3 :
| 12z Tickst 20,00 st (Jo... Tene 0:06 0.60
_ . Traffic ]
HEEIE Tickat 20,00 . 0
| e Ticket (20,00) m“' .
| =5 Tickst (20,000 s o)
| 15)1e Tickst 20,0 @ @ @ :
| 77 Ticket (20.,00) . ) s ctal . g_g
| e Tickst (20.00) {ancryma, . Balarw :
¥ 2@ Ticket 20.00 I@ @ [ 009 |
3 |Adm 0
: 3 [Operator a GamePoinkd GamePoints ) Add timermoney
| 6 |smn Jobn Smith 200
S e (P ][ Bsw ]
¥ smith {Jobn Smith) [Terminal 2]

anorymous) [GamePoirk2]
) ) r n | Wancrmmous) [GamePorts]
Terrninsl
L e s Lorders] lancrymens) [Acke]
& Rudrash Vokume Lanorymous) [Admin]
Time: Message Tum ee!
& 14:03:39  Tickst 9= Soid o

& 13:53:20  Top up sccount: Somebody + 5.00
Dl

The "List" button switches main screen from terminal icons to the list:



!WIOIIBM
eR | ceve®|[peo

(B ) (O 1w (@50 ]

Bo | [Csawm ] Ooe

Time: Message
& 19:03:39  Tickst 9: Sold
& 13:53:20  Top up sccount: Somebody + 5.00

D |Login [aasrs [paance | &
2 (arnymous) L
10 19 Ticket: 20,00
| 1n Ticket 20,00
| z2 Ticket 20,00
| 1303 Ticket 20,00
| 4 Tickst (20,000
| =5 Tacket (20.00)
1616 Ticket 20,00
| 77 Tickst (20,00
| s Ticket (20.00)
¥ 9s Tickst 20,00
| 3/dn 0
5 |Oparatar 0
& smith Jobn Smith 200
| 4 Somebody 500

Bl @

Skakion

(arnmols)

<
Terminal | Orders

() ™

Comee

L]

[ © asdtmaimoney | [ B 200 | [@‘Rafrm.l

Age  Time

L]

k15

Traffic  Time loft Balance  Payment
| loeel | _0:09 ] 0.90Pre-pad |

TR Frc-poid

|05 | o.50 R

(& pebest | [ D50 |

Fre-pad 1.50
Tiemee: 006 0.60
Traffic a
Cithers 1]
S 0.ED
Tax 2}
Tokal 0LEd
Ealance 0.50
© Add timefmoney

Ping Monitor

Monitor your Internet cafe terminals state and get a notification when a terminal is off or TrueCafe

Client is not running.



Setup  VMiew Tasks Tools Help
[ D New... ] [0 TOp—L.p] ’ ﬂSeH ] e m | @Start | | € Add timefmoney | | ﬁsmp | ‘ ’ @ Refresh ]
1D |Lugi| |Narr|e |Ealance | - | T | | % Stop |

P 2 (znonymous) 0 &
| 10w Ticket {20,00)
| uun Ticket (20,00) @ i @
| 1212 Ticket (20,00) Terminal 1 Terminal 2 Terminal 3
| 1313 Ticket {20,00)

14|14 Ticket (20,00)
: 15 15 Ticket {20,00) Click on a busy terminal. ..
| 1815 Ticket (20,00) Terminal Ping monitor
- 77 Ticket (20,00) Date Terminal Ping

88 Ticket 20,00
— olo = :ZJ'UU; 19.04.2010 11:52:13  Terminal 2 Mo Client (192, 168.2.101: 15825}
— 3 |Ad ! L 0 19.04.2010 11:52:18 Terminal 1 Mo (192, 168.2.1:15925)
— m 19,04,2010 11:52:18 Terminal 3 Mo (192,168, 100,3:15925)
_| 5 |Operator £ 19.04.2010 11:54:57 Terminal 1 Yes (192.168.2.1:15925)

19.04,2010 11:55:33  Terminal 1 Mo (192, 168.2.1:15925)
19.04,2010 11:57:15  Terminal 1 Yes (192,168.2.1:15925)
D Sell ticket
MName

;

Time: Message
Adm




Quick Setup

Open TrueCafe main menu > Setup > Quick setup

[ Quick setup ﬁ
Language [Eng*sh -
Currency £
Guest rates
Payment [Pust—paid - ]

Create pre-paid tickets

Change administrator password

Import customers

Show on startup [ oK, ] [ Cancel

1. Select language
2. Set currency symbol

3. Set guest rates

Select payment mode (pre-paid or post-paid) and specify rates for your quest customers.

Service
Hame Time
Minutes Price D Mew...
30 5.00
0 10.00
# Delete

Charge every minute

Minimal charge 0.00 £

& (o=




Minutes 30

Price 5.00 §

4. Create tickets

Read more on how to create and use pre-paid tickets

5. Change administrator password

6. Import customers

If you use to have any billing system before, you can import the customer list from MS-Excel file in the

appropriate format:

File (MS-Excel, *.us, *.xlsx)

C:\Tempiustomers, xlsx Browse. ..

Farmat

Pricing Payment

[{m package) *] [Pﬁ!‘ﬁid ']

Select Excel file and did: "Import”™,

Login Errar

4 L F




Terminals and Applications

Create, edit and delete terminals

= Workstations |'._ E| [E|
Workstations |F‘r|:|Files
[ [ Hew... ] [ A Edit... ] [ ¢ Delete ]
Mame in Lal  |IP address Prafile -~
Enabled |A&dministrator [127.0.0.1
_|’=amePaintl Enabled 192,165.100.1  |Game Station
_|’5amePaintz Enabled 192.165.100.2  |Game Station
__|'samePaint3 Enabled 192,165,100.3  |Game Station
_|'=amePoint4  Enabled 192,165,100.4 Game Station 4
_|’=amePaints Enabled 192,165.100.5  |Game Station
] Terminal 1 Enabled w51 192.163.1.1 Inkernet Stakion
| Terminal 2 Enabled w52 192.165.1.2 Inkernet Stakion
_ Terminal 3 Enabled W53 192.165.1.3 Inkernet Stakion
w

Close

Name field value is up to you.

Computer name field is optional. Specify a computer name (UNC) there if it differs from the Name
field.

Assign a terminal static IP address or select the dynamic IP option.

Press the Receive MAC button after IP address is assigned and the terminal is on. TrueCafe uses the
received MAC address to turn on the terminal remotely.

Terminal

General | Extra | irtual

Marne |GameF‘u:uint1 | @

Compuker name |GF'1 |

(if differs Fram the name abowve)

IF address
(=) skatic 1192.168.100.1 |
'D Dvynarmic

MAC | 111222333444 |

Receive

[ Ok l ’ Cancel




State: enable / disable terminal for TrueCafe administration.

Profile: select a pre-configured profile to display application and game icons in TrueCafe Client.

Price coeff: if you use terminal-dependent pricing, specify the pricing multiplier for this terminal. Price
coeff = 1 by default, which means the base pricing isn't changed for the terminal. Read more

Terminal rg|
izeneral | Extra |'-.-'irl:ua|

Skate | Enabled b |

Prafile |Game skation b |

[ ]Enable print prevention

Price coeff

(] 4 l ’ Cancel

Use Virtual tab to configure a thin-client terminal such as NComputing or Windows Terminal Server
one. Read more.

Terminal [5_<|
izeneral | Extra | Wirtual |

ser name | |

IJse this Field if vou run a Few virtual kerminals on the
same server (Windows Terminal Server, NComputing,
ek,

[ Ok l ’ Cancel

Arrange terminals

Move a terminal icon relatively to the real location of a terminal in your cyber cafe. Press the "Arrange
terminals" button, drag and drop the terminal icons and press the "Arrange terminals" again to save the
positions.



€ Add time/money @ stop
e e ee

Admin Terminal 1 Terminal 2 Terminal 3

e e e

GamePointl GamePainkz GamePoints

T | —

e’
Garne—bink

Grid size (pixels) |20 E @ Movement: cursor keys+ Alk

GarnePoinks (el =l gla=t

Shutdown or restart terminal. Start
application

Use the terminal popup menu to remotely shutdown or restart terminals or start applications on a
terminal:

2 Edi...
D et

Zkop..,

sell...
ﬁ Add time/money. ..
Mowe ta...

Start application...
Restart computer
Shutdown compuker

Q TrueiZafe Client Security. .,
Close TrueCafe Client

You can choose an application to start from the application list of a terminal profile or enter a path

manually:



Application r$_<|
Path |D:'|,Games'l,GT.ﬁ.'l,gta.exe |
Tab Marme Path
Canfig Conkral Panel conkral, exe
Config Reqistry Editor reqedit, exe
Config Services SEFYICES . MSC
Games Counter Strike E:\GamesZ5hcs. Ink
Games Cybercafe Rules ChDociovbercafe_rules. bxt
Fames Do 3 CrGames Doom3ldoom3, exe
Games FIFA [ Games\FIFAfifa.exe
Games Generals O\ GamesiGeneralsigenerals. exe
Eames Dv\EameshETAlgha, exe
Fames Heroes 3 [niGamesiHeroes 3 heroess . exe
Games Heroes 4 [niGamesiHeroes4 heroest exe
Games RHL [\ GamesiMHLNDL. exe
Games Yolurmne skdvol32.exe
Media MLsic explorer,exe Viserverimusich
Media Yideo explarer.exe Viserverivideno!
I_ (04 ] I Cancel

Setup applications

You can configure a set of terminal profiles. Each profile contains a number of applications that a user
can start. One profile can be assigned to many terminals. When TrueCafe Client starts, it loads a
terminal profile and displays a tab set with applications. A user can run any application by double-
clicking on an application icon.

Terminal [')Z|
zeneral Extra | Yirkual
State |Enahled b |
Prafile |Game Skation W |

’ TrueCafe Client Security. .. l

[ ]Enable print prevention

(0] 4 | ’ Cancel




TrueCafe Client

Login
Marne
Pricing

Payment

hat...

ﬂ Top-up...
Q Order,.,

Gﬁ.’_} Password. ..

L Log OFF |

smith
John Smikh
Standard

Pre-paid

1.50

Pre-paid

Time 0:00

Traffic
Cthers

Surn

[ R L R o R

Tax

Total D
1.50

Balance

Games ] Media |

- time left: 0:15

HFS
MW
FIFA MFS Mosk
Wanked
ounter Strike Doom 3 Cuake 4
a
Call of Duty  S.T.4.LKER. FarCry
Cvbercafe volume
Rules

Use the "Profiles" tab of the "Terminals" window to configure terminal profiles:




= Workstations |Z| |E| E|

Prafiles |

Warkstations

’ [ Mew... H A Edt... H 3¢ Delete ] ’BDesign...]

3

[ %

A Edi... ” 3¢ Delete ]

Tab |Name |F'u|:u|i-: |F‘ath L
_Cu:unfig Conkrol Panel Mo control, exe E:lGamesiC3ics. Ink
Config |Reqgistry Edibar - Mo reqedit, exe GamePoinkz
_CDnFig Services o sErvices.msc GamePoink3 @ GamesCSics. Ink,
Em Counter Strike C5 GamePoink+ @GamesiCSics. Ink
_|=ames Cybercafe Rules |Yes CADoccybercafe_
Games |Doom 3 Yes CrGames Doom3h,
:Games FIFA, Yes L\ Games\FIFALAF B
_|'zames Generals Yes [\ GamesiGeneral
_|Games |GTA Yes CrhGamesiGT A gh:
Games |Heroes 3 Yes [rlGames\Heroes:
:Games Heroes 4 Yes [\ GamesiHeroes:
_|=ames MNHL Yes L\ GamesiMHL NI
_|Games |Yolume Yes sndvol32, exe v v
ol 3 @@ >

Close

Set a tab name, a name and a start path (command line) for each application. You can use URL, email,

shortcut (.Ink file), Internet-shortcut (.url file), document (.txt, .doc, .xls, etc. file) as an application
path.

You can setup the alternative paths if the application has different paths on different terminals. Leave
the path empty to hide the application on a particular terminal.

Note that only administrator or users with "Applications" security option checked can configure
terminal profiles and start "Public" applications from TrueCafe Client.

Use the "Designer" window to change the positions of application icons on the screen and the size of
application pane.



Design

Media |

Cvbercafe Yolume
Fules
Do 3 Counker Skrike Generals aTh
FIF& MHL Hetroes 3 Heroes 4

arid size (pixels) |40 E}




Pricing
Pricing packages

You can setup individual time/traffic pricing for each type of your customers (general, students, VIPs,

etc.). Create as many pricing packages as many types of customers you have.

= Pricing
Packages Services
[ [ Mew... ] [ 2 Edt... ] [ $¢ Delete ] | [ 2 Edt... ] [ 3¢ Delete ]
Mame Public  |Discounts COrder # | | Mame Public  |Order A
Standard o discount) Z[-R burning
Employes Mo (no discount) 99 Coffes Yes Yes
Student Yes (no discount) 100 Juice Yes Yes
Prinking Yes Mo
w
— | Scanning Yes Mo
I{_-:J Computer rental kme) pricing...] Snack, fes fes
’ ﬁlnternet kraffic pricing. .. ] [+] Count traffic
Discounks
’ [ Mew... ] ’ & Edt... ] ’ $¢ Delete ] bt
am >
Fame Total  |Percent A prict charges
Time & prinking -50%: ’
= e, .. ] ’ Edit... ] ’ Delete ]
YIP {90% For all) Yes | — D o x
* || |Printer Service
SERMERIHP Laserlek 5L |Prinking
[ [ Hew... ] [ £ Edit... ] [ 3¢ Delete ]
Service Percent A
Time: a0 —
& Print Jabs, ..
™
Restart TrueCafe Server after you make any changes, ’ @Help ] ’ Close
Server Manaqger

Pricing properties

Simple mode:



Service @

M ame Time

Minutes Price D Mew...

30 5.00
&0 10.00 2 Edit...

Charge every minute

Minimal charge 0,00 g

e

Extended mode:

= name on receipt, if different from the base name

m taxing value and type: included in or excluded from the price
m time zones with individual pricing for each zone

= minimal charge

m test your pricing



Service

M ame Time M ame on receipt
[ ] Public [V] Continuous [ ] order
Tax, % 0 [mm =
Time Zones
Color  Mame D Mew Sun |Mon |Tue |Wed [Thu |Fri |5at
0D 0D
Default ——
a Delete 04:00
080D
12:00
16:00
20:00
Price
Minutes Price [ New... [ white -
; - o
&0 10.00 o0:00 | [23:59 | [@]Enabled
¥ Delete
[/]5un
| Ch inute
arge every minu [Z]Mon Fwed FF
Minimal charge 0.00 $ /] Tue [¥] Thu [/]sat
Test
Begin  09.12.2011 v 13:10 Calculate > Sum 0
Tax 0

End 09.12,2011 = 1310

Total 0
Armount D Mirutes

Details << "@HE‘P]EDK;[W

Customer default pricing

You can assign a default pricing package to any customer:



Customer, [5__<

Main | Access |

& Enabled &
Login |smith | Password, .,

Member

Marne |J|:|hn amith |

Balance 5.00

[ + 50,00 § ” + 10,00 § ]

’ +5.004 ” +1.004 ]
Pricing | Standard A
Payment |F‘re-paid A |

Time left EH

Date of birth |01j02/1980 58]

Description

(04 l ’ Cancel

If pricing isn't assinged, an operator chooses the package starting a session in TrueCafe Administrator,
or a customer chooses the package starting a session in TrueCafe Client:

Login |
Q Password |
Language |Eru;||i5h ﬂ
Pricing |Stan|:|arl:| ﬂ
M
Cptions == | [u] I Zancel
Choose package. ..

Only the "Public" packages are available for choosing.

Terminal pricing

You can use the terminal-dependent pricing feature if you need to change your base rate depending on
the terminal type, e.g. general Internet terminal or fast gaming terminal.

Use the terminal settings to specify the price coeff of a terminal. Price coeff = 1 by default, which means
the base pricing isn't changed for the terminal.



For example, if your basic rate is $5 per hour and the price rate of a terminal is 1.2, a customer is
charged $5 * 1.2 = $6 per hour.

Terminal r5_<|
General | Extra |'u'irtua||

Skate | Enabled b |

Prafile |Game skation w |

[ ]Enable prink prevention

Price coeff 1

o | [

Discounts

You can use discounts to lower the price of any package. TrueCafe provides two types of discounts:

m total - decreases the price of any service

m service specific - decreases the price of the specified services only

Public services

A service marked as "Public", such as printing, scanning, etc., can be added to a customer session
(terminal popup menu, the "Sell" item):



(]

ltem

Clienkt

Service MName Price
DR burning 1.00
Coffes 1.00
Juice 1.00
Prinking 0.05
Scanning 0.05

Snack.

e

2,00

E——— [ Canicel




Customers

There are three types of customer accounts in TrueCafe:
1. Guest. This is a customer account which you can use for any customer.
2. Member. Any customer which has balance in your cyber cafe. You create member accounts manually.

3. Ticket (time code). Pre-generated account which can be sold to any customer. You generate a
number of tickets for further use.

Customer account

Property Meaning

Enabled Whether this account can be used to login to
cyber cafe terminal

Balance Amount of money that is left on the account

Credit Maximum amount (negative) which a customer
owes your cyber cafe (negative). When a
customer balance exceeds credit amount, neither
a session can be started nor an item can be sold
to the customer.

Pricing Pricing package. If assigned, the customer can't
select another one when logging in.
Read more about pricing

Payment Pre-paid or post-paid method
Read more

Time left Approximate amount of time left based on
customer balance and selected pricing current
rate

Colour box Highlight a customer account in the customers list

and the sessions list



3

Customer

Main | Access |

Enabled Mermber
Login |J|:u:|:unde | Password, .,
Marne | |
Expire date | o El|
Payment |F‘re-paid L |

Ealance |:| el -100,00

[ +50,00 p. ] [ + 10,00 p. ]

[ +5,00p. H +1,00p. ]

Pricing |I{n|:| package) L |

Time left 0:00

Date of birth | o EI| ||:| Default V|

Description

o | [ cna |

Top-up (put some money) account

Select a customer in the list and press the "Top-up" button:

’ [ Mew... ] ’ﬁTDp-up...] ’ £ sell... ]

D |L|:u;|in |Name |Balance | ~
_ 2 |(anonymous) 0
3 | Adm ]
: 4 | Somebody 0
] S | Dperaktor ]
l 6 smith Jahin Smith 5.00
A Ticket 20.00

Enter amount of money to put onto account and amount of cash received (if differs), select the method
of payment (cash, credit card):



Top-up ]

Cuskomer |smith (John Smith) |

Current balance 5,““

Add 10,00

[ + 50,00 p. ” + 10,00 p. ]

[ +5,00p. ” + 1,00 p. ]

Mew balance 1 5,00

[ ] wirtual cash

Received |1IIIJIZIIZI | |Cash W
Camments
[ I l [ Cancel

Virtual cash

You can use the "virtual cash" concept to top-up an account without putting real money onto it. Virtual
cash doesn't impact your financial reports.

Programs

Create a list of programs which a customer can start from TrueCafe Client. Use a customer pricing to
select a program list for the corresponding customer type (main menu > Setup > Pricing > Pricing

packages):

Marne |0nLine-Gamers |
IF‘rn:nFiIe |games on-line w |I
Descripkion
Public
Discounts ||:ru:| discounk) Y |
Crder 100
K l ’ Cancel ]




Security

settings.

Option
Login

Reports
User access administrator

Applications

Terminal screenshot
TrueCafe Client Management

Max number of occupied terminals

Inventory administrator
Refunds
Change paid amount

Change time/money values

The other options are:

m Top-up customer accounts
m Start sessions

m Extend sessions

Only a supervisor account (Adm) or a "User access administrator" can change user security

Meaning

Can login into TrueCafe Administrator. Such
users are highlighted by red in the customer list

Can login into TrueCafe Reports
Can change user security settings

Can configure terminal profiles and use "private"
applications in TrueCafe Client

View remote terminal screenshots
Can close TrueCafe Client remotely

How many terminals can be occupied using this
account simultaneously

Configure inventory, add and remove items
Make refunds
Change the "Paid" amount value closing a session

Specify custom time/money amounts
starting/extending a customer session

Terminal type: Specify whether a customer is allowed to log in to desktop or Wi-Fi or any terminals.

Adm account rule. Administrator account (Adm) security settings can be changed only by Adm

himself. Administrator can change the security settings for any user account.

Login name rule. An operator can set an account login name when he creates a new user account. An

operator can't change his own login name. An administrator and user security administrators can change

any login name.

Password rule. An operator can set a password when he creates a new user account. Any user can

change his password. An administrator and user security administrators can change any password.

Enable/disable account rule. Only administrator and user security administrators can enable/disable

a user account.



Customer E

| Main |Doqme.-1ts|nccess|

Logon Reports

Create Edit Delete

Customers

Tickets

O

Services

OO O|E
&
NSRS

O

Terminals

[ Can sell tickets -
[ can sell items =
[7] User access administrator

[] Applications

[ Terminal screenshot

[ TrueCafe Client Management
[T Inventory administrator

[ Refunds

[¥] Change paid amount

[¥| Change time/money values
| Top-up customer accounts =

[ Start zessions
[ Fvtend seecinne

m

Max number of accupied terminals 2

0

Terminal

;e
|
Desktop PC

— Wireless (Wi-Fi)

| B sessions...| Loc | [ canel |

Scan customer documents

Scan customer documents such as a photo, passport, driving license, etc. Click on the customer icon to
scan a photo or use the Documents tab to scan any other documents.



Customer, |£

Main | Documents | Access |

| san ||| add. || oDeete |

Dacument 1 ipg

(. NEW YORK STATE )

"\- | = T e T oty Yeriies
[ _  FNHANCED ]
DRIVER LICENSIE

ID:012 345 678 - CLASSD
. DOCUMENT £ T
"SAMPLE, LICENSE

2345 ANYPLAGE AVE
ANYTOWN NY 12345

DOB: 06-09-85
SEX:F EYES: BR HT 502

Soefh Lot Dol | 5 HOME =

: =
IS5UE 1 033008  FXFIRES: 10-01-10 au1my

B Sessions... [ (a4 ] ’ Cancel




Tickets (Time Codes)

A ticket is a pre-generated customer account that can be printed, distributed, sold to a customer and
then used by a customer to log in to a cyber cafe terminal or top-up his current balance.

Any ticket has one of the next state at any moment: created, printed, sold, in use, used up, deleted. A
customer can log in to a terminal using a ticket which state is "sold" or "in use" only.

Open the ticket desktop for main ticket management operations. Use the state filter to display the

tickets in particular state only.

Display Al v Export bo M5-Excel
[ [ Mew... ] [ W Prirt ] [ {0 gl ] [ ¥ Delete ]
id Skate Login Password Face value Balance  Pricing Cuaner Expire date = #*
7 Created 7 oSpxpkom 20.00 0 Standard {anonymous)
g Created a rrmigj4fo 20.00 0 Standard {anonymous)
9 Created q wEx10el3 20.00 0 sStandard {anonymous)
10 Sold 10 1rlcsveri 20,00 20,00 Standard {anonymonus)
11 Sold 11 Ald3uzd 20.00 20,00  Standard {anonymous)
14 Sald 14 gakTxvze 20,00 20,00  Skandard {anonymonus)
15 In use 15 0gz0nhhe 20,00 19.80 Standard {anonymous)
16 Created 16 Jueziclg 20,00 0 sStandard {anonymous)
17 Created  HFi936e A5k 30 50.00 0 Standard {anonymous) 01.01.2007
15 Created aanzdibg w2s70zda 50.00 0 Standard {anonymonus) 01.01.2007
19 Created R0 ues ulikdzng 50.00 0 sStandard {anonymous) 01.01,2007
z0 Created feab5xjk, bopSzZpd 50.00 0 sStandard {anonymonus) 01.01,2007
21 Created  s37hbSa7 idrnjiet 50.00 0 Standard {anonymous) 01.01.2007
22 Created fargweds nikqur? ay 50.00 0 Standard {anonymonus) 01.01.2007
23 Created hafgt73c eyelpgnd 50.00 0 sStandard {anonymous) 01.01,2007
24 Created Syl gcjzyick 50.00 0 sStandard {anonymonus) 01.01,2007
25 Created  xfexBwvz ravebftj 50.00 0 Standard {anonymous) 01.01.2007
) Creaked 1A 1Rl SFntk?n Sn.nn N Skandard Annrrnn s ni.ni.enng
IUsed up kickets
0
@ 20 tickets have been created
Delete used up tickets ]
’ @ Help ] | Close

Ticket ownership

Any ticket belongs to an employee, who only can sell it. You can generate tickets for each of your
employee to let them distribute/sell tickets. If you set "guest" as a ticket owner, then a ticket is shared
for all employees.

Create tickets

Press the "New" button to display "Create tickets" dialog.

1. Specify whether the tickets can be used on PC, Wi-Fi or any terminals.



2. Enter the tickets minutes.

3. Enter the bandwidth limit in Mbytes.
4. Enter the tickets price.

5. Enter the number of tickets to create.

6. Set the expiry date (optional). You can select a fixed date, or a sale date + X days, or a first login
date + X days.

7. Set time of day limit. If time of day is specified, customers can't log at the other time using these
tickets.

8. Choose a login generation method: login = ticket id or login = random.

9. Select an onwer from the list of cyber cafe employees.

i "

Create tickets @
Terminals |.*3.n3,ir v| ﬂ:{]
Minutes 60 % (0 - Unlimited) |
Traffic § £ Mb,(0 - Unlimited)

Ticket price 20 % [~ Promation (Free tickets)
(]
Number 10 3
Expiry date
@) Fixed [Cos. 12,2011 = ("] Time of day
Beai End
: : ; Sale + L % |:'?I|:I|'| Q000
(7 Login + 1 5
Login
|Login =id -
Owner
[{anunmnus} - ]
oK | ’ Cancel

Print tickets

Select a number or tickets in the list and press the "Print" button.

Specify whether you want to print a number of tickets on the same page (e.g. A4) or cut every ticket (1
page = 1 ticket). The latter approach is useful when you print tickets on the receipt printer.



o )

Print @

Cut tickets

@ 1page = many tickets

(71 1page = 1 ticket

o | [ conca )

You can put the printed tickets in your cash drawer and sell them to your customers.

You can also export the list of tickets to Microsoft Excel or CSV for further external professional
design/printing.

Sell tickets online

Online sale means you register the sale at the same time as you give a ticket to a customer.

Select a ticket in the list on the main TrueCafe screen and press the "Sell" button. If "Print" is checked,
the ticket is printed when the sale is made.

If you keep your tickets pre-printed (e.g. in a cash drawer), you can just enter a ticket number in the
edit box and press the "Sell" button.

17 oyll71wg Ticket
| & |smnith Jobin Smith
4 | Somebody

22 uDxakrwt Ticket
26 ulcFmoxy Ticket
19 uka9phdj Tickek
24 vkSigd2c Tickek
21 wa30z3td Ticket

I
o o o o o o o O

[

ID |21 Sell ticket [+] Print
Sell tickets offline

Offline sale implies that you provide a customer with a ticket and register the sale a few later. For

example, your agents may distribute printed tickets during a day and register all the sales in the
evening.

Open the ticket desktop, select the sold tickets in the list and press the "Sell" button.

Use tickets to log in

Enter the login/password printed on a ticket on the TrueCafe Client Login dialog.



Use tickets to top-up balance

When a session is started, a customer can use a purchased ticket to top-up his balance in the TrueCafe
Client:

I © Top-up... Pre-paid 2. UD

e Time 0:08 0,22

Traffic 0
ﬂ Password. ., Others <
Surn 0.22
Tax ]

Bimor ] ™ 0.22
Balance 1. 7 8
mne left: 0:18 |

Delete and recover tickets

Select tickets you want to delete and press the "Delete" button. If you need to recover a previously

deleted ticket, select it and press the "Recover" button.

Use the "Delete all used up tickets" button to delete all tickets which have been completely used.

Promotional tickets

Use promo tickets to provide limited access for free in order to promote your shop, cafe, etc. When you
sell a promo ticket, you don't actually collect any cash and the corresponding amount is only added to
the promo totals (not cash totals) in the reports.

Wi-Fi/Desktop tickets

Create tickets which your customer can only use on either Wi-Fi terminals or desktop PCs. This is useful
when you provide different charge rates for Wi-Fi and dekstop sessions.



{(*) Simple pricing Expiry date

Minutes (%) Fixed ||:| - |
[al
Osale + e
() Advanced pricing
Otoon +
Login
| Login = id W |
Ticket price Mumber Cumrier
Z0 | i |1IZI E” ||{anu:unymu:uu5]l b |

[ ] Promation {virkual cash)

Terminal

Wireles

Expiry date

When you create tickets you can specify an expiry date, e.g. a fixed date, sale + X days, login + X
days. Tickets works on the date they expire, for example if the expiry date = 01 Jan, the ticket works
on the 1st of Jan, but isn't available any more on the 2nd of Jan.

If you want to create a 1-day tickets, specify expiry date = login/sale date + 0 days.

Custom ticket layout

Customize your ticket print layout, add/remove captions, add your cafe logo, etc. Edit tickets.layout
file in the TrueCafe folder. Preview ticket layouts.



-

Options

| General | Design | Buttons | TrueCafe Client| Tickets |CD-keys | kKeyboard I Scripts|

Printer

Ticket name by default

Login mask

Ticket terminal count limit by default

Design

Password
Length
i@ Letters and numbers

() Letters only

(7 Mumbers only

Example:

=]

[Microsnﬁ: ¥PS Document Writer

~)

Ticket

!
b=

Custom demo layout (see tickets.layout file)

Preview

i

Preview

myCyberCafe

10,00 p.

Login: test
Password: test

id 999

Expiry date: 06.04.2011
Terminal: Any

g: myCafe

(@]

| | cancl




Pre-Paid and Post-Paid Sessions

Pre-paid session has a time limit, based on a customer balance value and pricing current rate. Server
automatically stop a pre-paid session when time is over.

Post-paid session doesn't have a time limit. A customer charged after he ends his session.

Customer starts session from terminal

Use a customer login/password to login. Only member sessions with positive balance can be started in
this way. Guest sessions must be started on the server.

Read more about TrueCafe Client

Operator starts session from server

1. Guest session: double-click on a terminal icon.
2. Member session: drag-n-drop a customer from the customer list onto a terminal icon.

Select a pricing if none is set by default for the customer and enter a customer password if account is
password-protected

1) Pre-paid. Add time if needed and collect corresponding amount of cash:

New Session

X
Client | | Password |:|

Pricing

Payment:  Pre-paid

time left: 1:16 Current balance: 5.00 %

add time: Cazh received [pre-paid]:

b @ O b1+ @

’ + 60 mins ] ’ + 30 mins ] ’ + 50,00 % ] ’ +10.00% ]

’ + 10 mins ] ’ + 5 mins ] ’ +5.00% ] ’ +1.00% ]
(4 l ’ Cancel

2) Post-paid. Set time limit if needed. No cash is collected:



MNew Session

Pricing

Payment:  Post-paid

E3
Client | | Password |:|

| time: unlimited | Current balance: 5,00 %
add time: Cazh received [pre-paid):
e (3 [ s
’ + &0 mins ] ’ + 30 mins ]
’ + 10 mins ” + 5 mins ]

(04 l ’ Cancel

You can customize time/money buttons in options.

Monitor sessions

Press the "List" button to switch between terminal icons and the session list:

Q=||E|| [ | © addtmejmoney || @ stop || | & refresh |

Admin
GarnePoinkl

Station Customer Age Time | Time left

Balance  Pawment

GamePointZ  smith {John Smith) 16 0:10 ISR ER Fre-paid

GamePoink3

GamePoinkd | fanonymous) | | wmm | | -0.03 | Post-pai
GarnePoinkts

Terminal 1

Terminal 2 uakrwk (Tickek) o:10 NS Fre-paid
Terminal 3

’ %2 Refresh ] ’ 5 stop ]
Pre-paid 0
Time 0:01 0.03
Traffic 0
Cthers 0
aum 0.03
Tax ]
Total 0,03
Balance -0.03

| time: unlimited |

’ ﬁ.ﬂ.dd kime money ]

Extend session (add time/money)

Press the "Add time/money" button to extend a session:




L@.ﬁ.dd irne money |’ 5 stop ]

e @ @

Terminal 1 Terminal 2 Terminal 3
ulakmme, .,

1) Pre-paid. Add time and collect corresponding amount of cash:

«; Add time/money E

Payment:  Pre-paid

Current balance: 013 %

Add time: Cash received (pre-paid)

| +eomins || +3omns | | [ +s000$ || +1000% |

| +10mins |[ +5 mins ] [ +5.00% ” +1.00% ]
o ) [ o |

2) Post-paid. Set/extend time limit. No cash is collected:

« Add time/money

Payment:  Post-paid

| time: unlimited | | Current balance: 0104

Add time: Cazh received [pre-paid]:

[ + &0 rmins ” + 30 rins ]

| + 10 mins |[ + 5 mins ]

o ] [ conea |

Sell item (drink, snack, etc.)

Use the "Sell" terminal popup menu to add any service/product to a session:



Customer stops session

Use the "Log off" button in TrueCafe Client to stop your session.

Read more about TrueCafe Client

Operator stops session

Select terminal icon or session in the list and press the "Stop" button:

Close session

Opened sessions are displayed in the session list. Stopped sessions, which don't occupy the terminals,
are highlighted in grey:



Marne i

| fanonymous)

| smith {Jahn Smith) [GamePointZ

| uxakrrmt (Ticket) [Terminal 2]
{anonyrmous) [GamePaint4]

B Operator [Terminal 2]

hd

{anonymous) [GamePaoint3]

A

Double-click on a session, collect required cash (or accept a credit card), give change (or put it on the
customer balance) and press the "Paid" button. Select the "Print receipt" before if needed:

Session El
[ [ rew... H & Edi... H &9 Finish H 3¢ Delete ]

Service |Terminal |Llnits |T';.-'|:ue |Disu:u:-unt |.ﬁ.m|:|unt |Tax A
LTime GamePoink1 0:07 minuke 0,70 [
Traffic (Standari GamePaink 1 0 |Kbyte 1] o
- w
Balance Maney Ijl Pre-paid 5,00
Start 07.11,2006 18:40:49 | Time 0:07 0,70
Traffic 1]
Marmne |smith { John Smith) [GamePaint1] | Others o
S 0,70
Cuskarmetr |smith [Jahn Smikh) | s 0
Discount | {no discount) v | Totsl 0,70

TR

Put change inko balance
Prink receipt

A session can be closed automatically if:

- there is enough money on a customer balance and
- there are not any open orders

Use the "Close sessions" option to enable this feature.

Pause/resume session



You can pause any running customer session. A corresponding terminal is locked and a customer can't
login via TrueCafe Client on this terminal until you resume the session.

You can also pause all active sessions or resume all paused sessions using TrueCafe main menu ->
Tasks.

Browse sessions

Sessions window displays today/yesterday/this week/etc. customer sessions. Open sessions are marked
with bold navy font.

You can use sessions window to print a receipt after a session has been closed and disappeared from

the list of active sessions on the main screen.

= Sessions

Al time v [ @refresh | | [ PEde. | [ dwrritrecep: |

Receipk Created by |Balar

2006 12:13:15  [Closed (anonymous) [GamePaoint3] 10.00

14.11.2006 12:16:39 Closed (anonymous) 0,30 Adm
: 14.11.2006 12:17:08  Closed smith {John Smith [Admin] 0.07 Adm
_|20.11.2006 15:49:14 Closed (anonymous) [Terminal 1] 1] Adm
_|20.11.2006 15:52:4Z2 Dpen {anonymous) [ Terminal 1.00 Adm
20.11.2006 15:52:50 Open {anonymous) [Terminal ; 1.00 Adm
: 22.11.2006 13:10:42 | Closed Adm 117.95 syskem !
_|24.11.2006 13:45:15 Closed smith 1] syskem
_|27.11.2006 9:26:14 Closed Mew customer [Admin] 0,20 Adm 0
27.11.2006 10:365:54  Closed Mew custamer [Admin] 0.10 Adm
: 27.11.2006 11:31:11  |Closed fanonymous) [Admin] 1.00 Adm
_|27.11.2006 11:42:02 Closed (anorymous) [Admin] 10,50 Adm
_|27.11.2006 12:57:15 Closed (anorymous) [Admin] 10.10 Adm
30.11.2006 10:17:05 Open (anonymous) 1] Adm
: 30.11.2006 10:25:45 Open {anonymous) 1] Adm
_|30.11.7006 10:26:27 Dpen {(anonymous) 1] Adm
_|02.12.2006 13:03:10 Closed (anorymous) [Admin] 1] Adm =
<@ 3

Close

Refunds

Use refunds when your customer returns you some purchased items or you have to rollback an entire
customer session.

Refund feature is available on the sessions window (main menu > View > Sessions). You can only
refund closed sessions. When a refund session is created, use the Delete button to leave the refund
items only. Refund sessions are highlighted with red color in the list.



Sessions

B)X]
| V| [@Refresh] [ £ Edt. .. ] [ i Print receipt ] [ Refund ]

Marme Receipk Created | A

losed tanoryymous) [Terminal 1]
T014.12.2007 175427 Closed Somebody [Terminal 1]
7114,12,2007 18:09:55 | Closed Somebody [Terminal 1]

Session

@

Service Terminal |Llnits |T3.f|:|e |Disu:|:|unt |.ﬂ.m|:|unt |Tax |5
4 -3 item 300 -0.60F

<
Balance 15.45 Maoney III Pre-paid
Start 14.12,2007 18:09:55 | Time
Traffic
Marne |S|:|meb|:u:|';.:' [Terminal 1] | Others
Sunn
Cuskamer |S|:|meb|:u:|';.:' Tere
Discount Tokal -3.60
@ Refresh Cash w
Received
Change 3.60

Put change into balance

[]Print receipt




Shifts

Control your operators and cash flow using the shift management feature.

Every operator computer is considered as a cash desk so that each shift is linked to the corresponding
cash desk. When an operator starts working with the program collecting any payment, starting/stopping
customer sessions, etc., he has to start a shift. When he finishes working with the software, he stops his
shift.

When an operator starts a shift, he types in the program the cash amount he has in the cash desk for
the moment. When he stops the shift, he types the final cash amount for the time.

Any differences between actual and calculated amount are highlighted with red in the shift report. Use
View > Shifts report to browse the shifts.

You can start a shift manually (main menu Setup > Start / Stop shift) or automatically. Enable the
shift control feature (main menu > Options > Shift control) so that an operator can't collect any
payment unless his shift is started.

143,34

10 28.058,.20058 5:06:25  28.08.2005 10:47:27 ADMIN1 Operz Cpers o) 62,96
11 28.05.2003 10:47:43 23.05.2005 10:45:45 ADMIN1 tesk Cpers 62,96 62,96 0
12 28.058.2005 10:45:46 23.05,.2005 10:52:36 ADMIN1 Operz Admin 62,96 62,96 9.00
14 28.05.3 81,96 | F73.53
15 2a.na.4 Cashdesk ADMINL 16.50

16 23.058.3 227,95

Eeqin

17 29.05.3 603,51
15 70,084 27.08.2003 19:45:06 Beqgin, Calc 923,52 & 42,70
20 30.05.3 762,49

Al time: v| [ 2 Refresh ] [ Export bo M5-Excel ] | # ede.. |
10 |Be-;|in |En|:| |Cash desk, |Operatu:ur 1 |Dperatu:ur z |Begin. Calc|Begin. Fau:t|F‘aiu:| |En|:|. Calu:|Enu:|. Fack | #
| 6 26,08,2005 20:09: 16 27.05,2008 7:59:13  ADMINI Oper3 Cper3 G5585.93 885,93 197.88 1083.581 | 1083.81
727.08.2005 7:59:33  27.05,20038 19:42:31 ADMINI Operl Cperl 1083.581 923,52 923.52 923,52
8 27.08,20058 9:28:49  27.05.20058 15:10:24 |ADMINZ Adminz Adminz 17.00 o) 11.63 11.63 11.63
D o/27.08.2008 19:45:06 |25.08.2008 8:00: Oper3 : 143,34 | 148,34

62,96 62,96
62,96 62,96
71,96 71,96
g1.9a g1.96
355,49 | G855.49
16.50 16.50

22795 22795

603,51 | 603,81

42,70 42,70
184,59 184.59
V249 TeZ.49

326,49 326,49

235,85 935.485
112,14 112,14
1092,93 109293 | ..

Close

| 2tmosd 6.3 $ 326.49
22 31.08.3 935,85
| 2331083 [ € Top-up... ][ Paid... 112.14
24 01.09.3 1092.93
End
28,08, 2005 5:00:45 End. Calc 148,34 %
Oper3 End. Fact 145,34 | 4
o g




Point of Sale, Cash Drawer

You can sell drinks, snacks and other products to your cyber cafe customers.

Walk-in sale

Use a walk-in sale for guest customers who don't use cyber cafe terminals. Click on the "Walk-in sale"

button in the toolbar:

Management Tools Help

B | @ Vg 80
’ [ Mew... ]’ﬁTDp-up...]’ £ sell..

)
D |L|:u;|in |Name |Balance | ~
2 |(anonymous)
3 |Adm
4 | Somebody

I
Lo S e I e Y o

| S | Dperaktor
l & smith John Srith 5.00
77 Ticket 20,00

Select an item, enter quantity and press the "Add" button to add the item to bill. Double-click on a item
to add it with quantity = 1. Double-click on an item in the bill or press the "Remove button to remote the
item from the bill. Press "OK" when finished.

You can use the inventory system to control item Available amount or use your barcode scanner to

sell the items.



Sale le
Cuskamer | | ‘E_Q

Pricing | Standard W |
SErvice Mame Price  Awailable
ZD-R burning 1.00
Coffes 1.00
CYD-R. 0
Juice 1.00 330
Prinking (black and white) 0.05
Prinking {colour) 0.10
Scanning 0.05
Snack, 3.00 g0
I1SE Flash 1]

Barcode | Item(s) 1.00 D Add
Eill Mame Tkern(s) | Amount 3 remove

Juice 1 1.00
Snack, z .00
Coffee 1 1.00
Total 8.00

[ K l ’ Cancel

Close the sale. Collect cash, give change and print a receipt if needed. Press the "Paid" button when
finished.



Member sale

Member sale is like a walk-in sale, which is made for a particular member.

Select a customer in the list and press the "Sell" button:

If the member account is pre-paid and there is not enough money left on the balance, you will not be
able to make the sale.

Cash drawer

Use TrueCafe main menu > Tools > POS. Cash drawer to connect program to your cash drawer. Cash
drawer opens when you change a customer balance or start/extend/stop customer sessions.



POS. Cash drawer

|Ise cash drawer
Paort [CDM 1
Baud rate [gﬁuu
Command #0

Test




Inventory

The inventory system helps you to...

m Control available items in the stock

m Use your barcode scanner to sell the items

Use main menu > Setup > Inventory to open the Inventory management screen:

= Inventory

[ DNEW... ][ uDeIete ][ + Itemis) ][ - Tkemis) ]

Mame |P.'-.failal:|le | s Date |Name |F'.m|:|unt |Llser

10.09,2007  Juice Adrn
05.09.2007 | Juice Admn
06.09,2007 | Juice Adm
0z.09.2007 | Juice &
£2.08.2007 | Juice Adrn
20.08.2007 | Juice Admn
01.08.2007 | Juice Adm

Create items

Click on the New button and select the new inventory items from the list of services:

Selection [5_<|

CD-R burning

v DYD-R
Printing {black and white)
Printing fcolour)

Scannin
v _I

I 8] 4 ] ’ Cancel ]

+ Items (Increase Amount)

Increase amount of a particular item in the stock.



Enter the item amount manually or use your barcode scanner for each item:

+ ltem(s) E|
Mame |_'I|.|i|:e |
Armount 4 E‘

Barcode |
5423653210925
4E92567921559

|. 4 J ’ Cancel ]

- Items (Decrease Amount)

Decrease amounts of a few items in the stock.

Select an item and enter the amount manually or use a barcode scanner:



- ltem(s)

X

SErvice lame Price Hvailable @
Coffees 1.00 ]
Juice 1.00 330
Snack, 3.00 n

Barcode | | Itemis) 5.00

Eill Mame Tkernis) | Ama... 3 remove
Juice | 5] 5.00]
Total 5.00

Ok ] ’ Cancel




Instant Messenger (Chat)

Organize a chat between operator and a customer on any terminal.

When a new message appears while the chat window is closed, the unread messages indicator is
displayed in the toolbar.

Press Enter button to send a message. Press Esc button to close the chat window.

O

Terminal Terminal 0

Terminal O
Terminal 1 14:54:26, Terminal 0:

Terminal 2 Hello, | need your assistance!
Terminal 3

14:54:41, Adm:
Go on please...

14:56:30, Terminal O:
Please let me know which network printer |
can print my colour photos on?

YRE your me

Send text message to terminal

Send a text message to a terminal in order to notify your customers about an important event or
provide them with any other information.

Use a terminal popup menu -> Message if you want to send a message to a single terminal.

Use main menu -> Tasks -> Message to send the message to all terminals in your cyber cafe.



= Message

Dear customers!

Cur shiop will be clased in & minukes, Please cansider sawving
wour data and finishing sessions,

Message

& Dear customers!

Cur shop will be closed in 5 minukes,
Please consider sawving wour data and
fimishing sessions,




License Key (CD-Key) Management

Cut down your game licensing expenses using the CD-key management system. Purchase a quantity of
licenses to cover simultaneous gameplay vs. purchasing a license for every terminal where a game is
installed.

TrueCafe license key management works the following way. All your game keys are stored in the
TrueCafe license key pool. When a customer starts a game on a terminal, TrueCafe dynamically
reserves the next available key and send it to the terminal. When the game is ended, TrueCafe delete
the reservation and returns the key to the pool.

Maintain license key list

Use the CD-key list (main menu -> Setup -> CD-Keys) to maintain your license key pool. Add, edit or

delete your games and license keys.

« CD keys B=1/E3
[ 5 Mew... ] [ £ Edt... ] [ 3¢ Delete ] ’ [ Mew... ] ’ £ Edit... ] ’ 3¢ Delete ]
Mame |Ke';.fs | A 1D |Ke':.f L
] Battlefield 2 0 L 1 00001111222233334444
] Battlefield 2142 0 ] 2 D5556eeaE Y TEEE52999
| Call af Doty 1]
Call of Doty 2 1]
: Command & Conguer: Generals n
| Command & Conguer; Generals Zero Hour n
| Command & Conquer: The First Decade 1]
FarCry 0
Dreazoor |2
] FIF& 2005 0
] FIFA Manager 2007 0
Half-Life: Counter-5Strike 1
: Lord OF The Rings: Rise OF The Witch King n
| Lord ©f The Rings: The Battle For Middle Earth 2 n 0
] ME&A Live 2007 o =
Meed For Speed: Carbon 1]
: Meed For Speed: Most Wanted 1
| Meed For Speed: Underground 2 n
| Quake 3 1]
Quake 4 1]
B 0

Unreal Tournament 2004

[ ™ applications. .. ] ’ @) Help ] [ Close

Configure game list

You provide your game license keys to a customer via game shortcuts on TrueCafe Client programs
panel. Use application profiles (main menu -> Setup -> Terminals -> Application tab) in order to assign
your game license keys to game shortcuts.

Read more about application profiles




Applications

[ [ mew... H 2 Edit... H 3¢ Delete ]

Tab |r'-.lame |F‘ul:u|i|: |CD-kE':.-'S th ~
Zonfig Conkrol Panel Mo dontrol, exe
: onfig Registry Editor Ho negedit.exe
Zonfig Services Mo FErvices. msc
I:ZI:nunter' Strike Half-Life: Counker-SHE HyGames)Counter-3krike 1,608
GRames Cybercafe Rules Yes qDocovbercafe_rules. bxt
: GGames Doom 3 Yes 0:Games)Doom3doom3. exe
_|'=ames FIF&, Yes FIFA 2007 B:\Games\FIFA 074 fifal?. exe
_|==ames Generals Yes :Gamestizeneralsioznerals, exe
GRames aThA Yes 0 GamesiiaTA Qs exe
: GGames Heroes 3 Yes O:GamesiHeroes3heroes3, exe
_|'=ames Heroes 4 Yes O:zames\Heroes4\heroest. exe
_|==ames MFS 22 Yes B hzamesitNeed for Speed Mosk W
GRames MFS Most Wanted Yes Meed For Speed: Mo B\Games\Meed for Speed Mosk W,
: GGames RIHL Yes O:Games\MHLNHL exe
_|'=ames Yolume Yes shdvol3z.exe
| Media PLsic Yes geplarer, exe Vserverimosich
_ Media Widen Yes geplarer, exe \serverivideo!
b
<) >

Use license keys

In order to request and apply a game license key, customers have to start the game from TrueCafe
Client game panel:



TrueCafe Client

Login
Marne
Pricing

Payment

hat...

ﬂ Top-up...
Q Order,.,

Gﬁ.’_} Password. ..

L Log OFF |

smith
John Smikh
Standard

Pre-paid

Pre-paid

Time 0:00

Traffic
Cthers

Surn
Tax

Takal

Balance

1.50

[ R L R o R

1.50

Games ] Media |

- time left:

0:15

FIFA

ounter Strike

| of

all of Duty

]

Cvbercafe
Rules

s
MW

MFS Mosk
Wanted

Doom 3

2. T.ALEKER.

B

volume

If no available license key was found, a warning message is displayed to let a customer decide whether

he is going to start the game anyway:

o |

" ':, MFS Most Wanted: no license key is found, Do you want ko skart the program ansmay'?
-

Browse and delete key reservations

To browse the currenlty reserved license keys and failed key reservations use main menu -> View ->

CD-Key reservations.

You can manually delete any reservation if you have decided that the key should not be longer reserved

by a particular terminal.

When deleting a reservation, a corresponding game process can be terminated as well. Use options to

turn on this feature.



= CD-key reservations E| [z|

42 Refrash ][ # Delete ]

Cuake 4 20.03.2007 12:10:27  |Terminal 1
Cuake 4 20,03,2007 12:15:10 | Terminal 2 2 303 Dn\Games\Quake $\0uaked.exe
Quake 4 20,03.2007 12:4::42  Terminal 3 3 1312 DelGamesiQuake $00aked . exe
b
am >
Failed reservations
Game Date Terrminal |Ke':.f 1D |F'ID |Mn:u:|u|e L
L Cuake 4 20.03.2007 14:31:32 | Terminal 4 n 2274 Dn\GamesiQuake 4\,Quaked. exe
| Quake 4 20,03,2007 14:31:192  Terminal 4 0 523 DGames\Quake $Quaked. exe
b
am >
’ {7 Help ] | Close

Steam by Valve Support

TrueCafe supports Steam game delivery system by Valve Corporation.

Read more



Power Management

TrueCafe power management features allow you to saver power, which actually means to save money,
in your cyber cafe.

Shutdown idle or all terminals

Shutdown idle or all terminals in your cyber cafe by one click in main menu (Tasks -> Shutdown...):

Message. ..
Chat...

Pause all sessions

Fesume all sessions

Shutdown Idle Terminals
Shutdawn All Terminals

Shutdown idle terminals automatically

You can set a timer which turns off any idle terminal automatically after X minutes has gone. Use
options to enable this feature.

Turn on terminal remotely

If a terminal is off and you need to start a customer session on it, you can turn it on remotely:

@ Refresh Wolume

Shutdawn

Restark Muke




Daily Report

You can analyze your cyber cafe daily activity and financial information using a brief daily report. It
displays top-ups, sales made, services provided, detailed log of actions and total cash received for
selected period (today, yesterday, this week, last week, etc.). Also, you can export the data to MS-Excel

or CSV for further analyzing.

« Shift Report M[=](E3
Today v| | sjeone v || eii1j2006 v | [ @ Refresh | [Export to Ms-Excel
Dake Login Mame Tvpe Paid | Deduction | Service Units  Pricing Workskation
g/11/2006 ... smith John Smith Top-up  5.00
8/11/2006 ... smith John Smith Sale 1.00  Coffes 1 Standard
g/11jz006 ... smith John Smith Sale 6,00  Snack Z Standard
ar11jz006 ... smith John Smith Sale Z.10 0,10  Time 1 sStandard  #Stakion 3
g/11/2006 ... {anonwym... Sale n.60 0,60 Time 6 Standard  #Station 1
< *
Top-up 500 Sales F7.00 | Services 0.70
Login Arnounk Mame Units armount|| Mame Units Armounk
smith 5.00 || Coffes 1 1.00/| Time 7 0.70
Snack. 2 .00

Cash received

Top-up S.00

Post paid 2,70

Total T.TO
< 3] = >

Close

Daily report for operator

When an operator runs the daily report, he/she only gets his/her sales and totals.



Sales Report

Sales report (main menu > View > Sales) displays detailed sales

by customer, service, terminal and operator values.

records and allows you to filter the list

|T|'li5 week V’| [ %7 Refresh ] [ Expart ta M3-Excel ]
Cuskamer Service Terminal Operatar
| vl | vl | vl | v
i Session (Begin End Custamer Setvice Terminal|Units |Amount|Tax|Paid  |Cperator | <

09,20 134 |22.09.2

22.09.2008 6:46:23
22.09.2005 7:11:44
Z22.09.2008 711746
£2.09.2008 71957
22.09.2008 715506
22.09.20058 7:56:02
22.09.2008 715354
£2.09,2008 5:06: 13
22.09,2005 §:15:01
22.09.2005 5:19:09
22.09.2008 8122119
£2.09.2008 §:27:42
22.09.2008 5:30:44
22.09.2005 5:44:30
22.09.2008 8:54:47
£2.09.2008 9:01: 26
22.09.2008 9:01:35

ANOrymaus]

22.09,.2008 7:Z{anonymous)

fanonymous)
22.09,2008 &1 {anonymous)
22.09,2008 ;0 {anonymous)
22.09,2008 9: 2 {anonymous)
22,09,2008 9:C{anonymous)
22.09,2008 82 (anonymous)
22.09,2008 5:4lugakamen
22.09,2008 58:2 Oper2
22,09,2008 3: 2 {anonymous)
22,09,20058 9:Ctuss
22.09,2008 90 {anonymous)

fuss
22,09,2008 10;{anonymous)
22.09,2008 10:{anonymous)
23.09.2008 14 {anonymous)

Time {Operato&-10

Time C-03
Tirme A-01
Prink by a-01
Time a-03
Time Aa-10
Tirme A-05
Time A-15
Time a-02

Time (Users) |A-16
Time {Operato A-10

Time a-12
Time (Users) | A-03
Time Aa-10
Prink by A-03
Time a-14
Time a-12
Time A-09

79
13
15
a7

93
a7
30
&2

40
30

a7
a5
1773

3.03
1.00
4,50
3.03
1.00
9,10
£.63
3.00
1.83

1.00
3.33
3.00
2.10
6,70
.30
5927

Qperz
Cper2
Qperz
Qperz
Qperz
Cper2
Qperz
Qperz
swsker
syskem
Cperl
swsker
Operl
syskem
Cperl
Operl
Operl

W

Close




Traffic Calculation and URL Log

You can calculate and charge a customer session Internet traffic and monitor terminals' URLs. Use the
TrueCafe Internet settings screen to turn on the traffic calculation or URL log features (main menu >
Tools > Internet...):

= Internet, URL , Wi-Fi

Select a network adapter which connects vour server computer
ko wour cuskamer kerminals:

Adapker | Local Area Connection 2 (192.165.0.1) w
TrafFic

Incoming traffic

Cukbgaing kraffic
JRL log

URL log
Exclude |.I:|m|:| .gif .jpg Jjpeq .png s oss Lico
Wi-Fi

Wi-Fi billing

’ @ Help ] I (o]4 l ’ Cancel

URL Log

Keep track of the Internet websites and pages which a customer opens on your cyber cafe terminal. Use
the terminal popup menu to browse the list of URLs for current session. Use main menu (View -> URL
log) to display the total log.

URL log is data is stored in a detached database (TrueCafeTraffic.mdb)



EOX

V| [ 5 Refrash ] [

Expart ko M3-Excel

£2.02,2007 13:02:54
£2.02,2007 18:02:49
22.02,2007 18:02:33
22.02,2007 15:02: 26
22,02, 2007 13:02: 25
£2.02,2007 18:02: 16
22.02.,2007 18:02:15
22.02,2007 15:02:15
£2.02,2007 13:02:09
£2.02,2007 18:02:05
22.02,2007 18:02:00
22.02.2007 15:01:49
£2.02,2007 13:01:41
£2.02,2007 18:01:10
Z22.02.2007 18:01:10

Source IP

192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,
192,168,

in (&0 (00NN N dnn i @nn i dn

n

w.digg.com

v, digg.com

v, digg. com

v youtube., com
v youkube, com
winwy wahoo, com
srd.wahoo.com
vy ahioo, com
us, a2, yimg.com
us, b, yvahoo,com
v, yahioo, com
us.il.virng.corm

us, a2, yimg.com
winwy wahoo, com
C.microsoft, com
rn.webkrends, com

JHGcEhe=&hb=0MS610162LEA
JHG?hc=8hb=DMS6101 6ZLEASEENIRd=1&hv=6E
f
ladmp, swfrvids=HzZ 4% -0 7N IMEeur|=)index&durl=t
!
{p.gifPt=11721601168_vlp=A9FJuuZ0vt1Fa0ab:
IM=575194, 10135569, 10946482, 7674020/ D=yah
Ip.gif?t=11721601168_vlp=A9F JuuZ0vt 1FaG0A0:
Jus . wimg.comj'a) 1-fjavalpromotions/grf070222 s _
{b?P=drHpnoFluubi_i1dRAIUFCPCW 3R 7hydvnQa
I _vlh=x30DMTFrfGhECW [xBFOT AZI3MTY xMDKECT
s wirng, comnfifrankl w0603 vodel, swk
Jus . wimg.comj'a) 1-fjavalpromotions/grf070222 s _
!
[trans_pixel, asprsource=wwndTYPE=PY&P=en_u
[dcsdfavsz99kTmayin2jzupyr _1sZefdes, gif tedosd:
>

Close




Point-of-Sale. Receipt

Print a receipt when you close a session or sale, top-up a customer account, sell a ticket or extend a

session.

A receipt consists of a number of sections. A section can be text, a picture (e.g. the cyber cafe logo), a
service list, tax, sum total, etc. You can add, delete or modify any section, move a section up or down,

change font and alignment, select a picture from disk to put on a receipt, underline a section.

Select a default printer for your receipts, setup a receipt position on paper (left, top), receipt width,
section height and margins in millimetres, specify whether a receipt border is printed.

Also, you can modify a pre-defined labels such as "Total", "Tax", "Amount", etc., translating them into
your own language (the "Labels" button), and print the test receipt.



Receipt

Printer

HP LaserJet 1100 (MS)

Print close session receipt:
Print top-up [ ticket receipt

Prink extend session receipt

Print border
Left 20 [ Margin |3 [ Section height |7 [%]
Top 20 [ width |60 [ Section margin |1 [%]
’ [ Mew ] ’ i= Lahels...
-
S myCafe ’ # Delete ] ’ o Print
ryCafe! address; phone: 333-222-333 Mave Lip

Receipt 1

05.06.2009 11:435:21

Session -1

Mame Armounk Zosk
1. Service 1 10 12.30 %
2, Service 2 z0 24,60 %
3. Service 3 30 36.90
4, Service ¢ 40 49,20 %
Sum 123,00 %
Tax 24,60 %
Tatal 147,60 %

Thank you!

Move Dawn

Tvpe

| Texk

vl

Inderline

Texk

|m';.=CaFe: address; phone; 333-222-333

(04 l ’ Cancel




Options

General

Design

Buttons
TrueCafe Client
Tickets
CD-Keys
Keyboard
Scripts

Option

General

Club name

Language

Close sessions after log

off
Disable multiple login
Shift control

Server. New session.
Password required

Rounding

Meaning

Your cyber cafe club name
TrueCafe interface language

Automatically close a ticket- or any pre-paid sessions: update the customer
balance and delete the session from the active sessions list

Don't allow simultaneous logins using a single account
Enable shift control. Started shift is required to accomplish any transaction

A customer password is required to start a session from the server side

Round total session amount. For example, if Rounding = 0.5 and the
session total = 1.30, it's rounded to 1.50. Rounding disabled when = 0



.

[ Options @

General | Design | Buttons | TrueCafe Client | Security | Tickets | CD4eys | Keyboard | Scripts |

Club name myCyberCafe @

Language [English - ]
’ Currency =5 ... ]
Close zessions after log off [Any pre-paid v]

[ Dizable multiple login
[] shift control
Server. New session., Password reguired

Rounding 0

’ @ Help ] [ Ok l ’ Cancel
Display log Display the system log pane
Display bottom pane Display the bottom pane (remote terminal screenshot, orders, etc.)
Display session Display the brief session info pane
Display tickets Display the sale ticket pane
Accept orders Display the "Accept order" dialog when a new order is received
automatically
Refresh How often a selected terminal screenshot, task list, etc. is refreshed
terminal/screenshot every
X sec

Refresh session every X |How often the sessions pane is refreshed

min

Don't refresh when a Prevents the session pane from being refreshed when a dialog window
dialog is being displayed  (start session, add time/money, etc.) is being displayed

Ping terminals each X sec |How often TrueCafe pings terminals and displays a ping status. We
recommend keeping this value about 60 seconds or higher in order to avoid
system slowdown



Options

General| Design |Eiutt|:|ns TrueCafe Client || Tickets | CO-keys

Display log

Display bottom pane
Display session
Display tickets

[ ]Accept orders automatically

Refresh terminal/screenshot every seC

IE]'min

Refresh sessions every
Don't refresh when dialog is being displayved

Ping terminals each 30 E]' seC

[ @ Help ] | oK | ’ Cancel

Buttons

Time/money warn when Mimimal amount of time/money left when warnings (colours, dialogs,

left sounds, etc.) are displayed
Time/money button 1, Amount of time/money that is added to a session when you press the
button 2, etc. corresponding button on the "Add time/money" dialog

Show time left warnings | Display warnings on the server side as well as on the client side
on the server side



Options
meneral || Design | Buttons
Time

Warn when left

Button 1

Button 2

Button 3

Button 4

[ ] 5how "time l=ft" warnings on the server side

X

|TrueCaFe Client || Security | Tickets | CD-keys | Keyboard

Money

iy wearn when left 5,00 L2

mmin Button 1 50,00 %
0 miin Button 2 10.00 %
10 i Button 3 %

mmin Button ¢ 1.00 %

’ E?}Help ] I (o]4 l ’ Cancel

TrueCafe Client

Buttons

Login automatically when
Windows login = TrueCafe
login

Minimize session window

Close running applications
when a session ends

Close programs delay

Clear History and
Temporary Internet Files

Log off when screensaver
starts

Log off when Windows
logs off or shutdown

Restart terminal when
session ends

Printing confirmation

Lock screen when
network disconnected

Show time/money left
dialog

Enable/disable session screen buttons such as Chat, Order, Log Off, etc.

Start TrueCafe customer session and unlock a terminal screen
automatically when Windows user login is found in your TrueCafe customer
list. This is helpful when all your customers have personal Windows user
names so they don't need to login to TrueCafe when then login to Windows.

Minimize the session window to the Windows taskbar when a customer logs
on

Automatically close all running applications on a terminal when a customer
session ends

When a customer session is stopped you can close running programs with
some delay. Meanwhile the customer can add the extra time to his session
and continue working with his programs

Automatically clear Internet Exporer History and Internet Files folder on a
terminal when a customer session ends

Automatically log off a customer session when a screensaver starts on the
terminal

Automatically log off a customer session when a customer logs off from
Windows or shuts down the system

Automatically restart a terminal when a customer session ends

Displayes the pages/charge confirmation dialog when a customer prints a
document

Lock a terminal screen when network disconnection detected

Display the warning dialog to a customer when his session has critical
amount of time/money left



Time/money left sound
file

A warning sound file that is played to a customer when his se
critical amount of time/money left. Please note that this must

ssion has
be either a

local path to a file on a terminal computer or a network path to a shared

file(e.g. \\SERVER\SHARE\warning.wav)

Shutdown an idle terminal Shutdown a terminal after period of inactivity

after X min

Options

[] Printing confirmation

Show time left dialog

Time left sound file

Buttons
Top-up Chat Log Off
Order Password

[ Login automatically when Windows login = TrueCafe login
|:| Minimize session window

[] Close running applications when a session ends

Delay 0 %

[] clear History and Temporary Internet Files
[ ] Log off when screensaver starts
Log off when Windows logs off or shutdown

[ Restart terminal when session ends

[] Lock screen when network disconnected

(]

| General | Design | Buttons | TrueCafe Client | security | Tickets | CD4eys | keyboard | Scripts |

sec

[] Show money left dialog
Maney left sound file

-

warning. wav warning. wav
Shutdown an idle terminal after 0 % min
’ E?} Help ] [ oK ] ’ Cancel
Printer Ticket printer if not your Windows default one. For example, you can select

your POS printer as your ticket printer
Ticket name by default A name which is assigned to tickets when you create them

Login mask Add preffix/postfix to a ticket login. When not empty, must contain %s
(e.g. 200801%s). Login mask is used for login = random ticket
generator option only.

Ticket terminal count limit | Default "Maximum number of occupied terminals" when you create tickets
by default

Design Ticket layout on a printed page

Password Specify a password length, choose whether a password contains letters or
numbers or both, select the upper or lower case and view an example



[ Options @

| General | Design I Buttons I TrueCafe Client I Security | Tickets |CD-keys | Keyboard | Scripts|

Printer [ v]

Ticket name by default Ticket
Login mask

Ticket terminal count limit by default 0 &5

Design Horizontal simple -
Password
Length 8 =
(@) Letters and numbers (7 Upper case
() Letters only i@ Lower case

(71 Mumbers only

Example: Tuuztdsh

| @rep | [ ok | [ cance

.

CD-Keys

Enable CD-Key Enable or disable CD-Key management system
management

Terminate process when
you delete a reservation



Options

| General | Design || Buttons | TrueCafe Client || Tickets | CD-keys

Enable Z0-Key management

Terminate the process as well when vou delete a reservation

[ @ Help ] | oK | [ Cancel

Keyboard

Specify the commands to run when you press F2..F9 keys

Options
| zeneral | Design | Buttans | TrueCafe Client | Tickets | CD-keys |W
F2 |Mew customer v |
F3 | ialk-in sale v |
F4 | Top-up v|
F5  |Refresh v |
Fé | Aild time/money v |
F7 |chat v
Fg Message v |
o 2
’ @) Help ] [ o ] ’ Cancel

Scripts

Run external programs when TrueCafe Client logs on/off. You can use customer_id, terminal_id,
pricing_package_id command line parameters, which are replaced with actual values when the script is
called.



Options

X|

| zeneral | Design | Buttans | TrueCafe Client | Security | Tickets | CD-keys | Keyboard | Scripts

TrueCafe Client, Log an

|C:'|,Cu:unF'l,Iu:-g-:un.|:uat cuskomer_id pricing_package_id

TrueZafe Client, Log off

|C:'|,Cu:unF'l,Iu:-g-:uFF.|:uat cuskomer_id pricing_package_id

[ @rer | |

K

l ’ Cancel




Client

Lock terminal

TrueCafe Client locks a cyber cafe terminal.

Login |

Password |

Language |English ﬂ

Options == | Enter | |

Configure

Press the "Options" button to display the configuration pane, enter an IP-address of the computer where
TrueCafe Server is installed.

Enter a background picture file name.

Select a dial-up connection if you want to connect/disconnect it when a customer logs on/logs off. This is
useful in case you have a remote terminal connected via GPRS, etc.

You can change options freely in the demo version TrueCafe. The options are protected with the
unlocking code in the registered version.



TrueCafe 4.6.1104.6. Logon (Serge)

Legin I

Password I

Language |Engiish |

Options << | Enter I Zancel |
Server IP |192. 168.2.1

Connect

!

Background IC:‘I,temp‘lbad(ground.jpg

Security... |

Background

Use the Background option to specify either a picture or web page to be displayed on the TrueCafe
Client background when the terminal screen is locked, e.g:

C:\temp\picturel.jpg (local path on the terminal computer)

http://www.website.com (don't forget to specify http://)

Display session info

A terminal is unlocked when a customer enters his name/password or a cyber cafe operator starts a
customer session remotely. When the terminal is unlocked, the session information window appears. A
customer can top-up his balance using a ticket, change his password, order a snack/drink or stop the

session.



K

« JrueCafe Client

Login smith

Mame John Smith

Pricing Employes

Pavment Pre-paid
Pre-paid 2.00
Time 0:08 0.22
Traffic ]
Cthers ]
= 0.22
Tax 0
Tatal ﬂ. 22
Balance 1. 78

mne left: 0:18 |

~
15 Start o time left; 0:16

Select pricing while logging in

When a customer is logging in, the "Service package" list might appear. This depends on pricing
configuration and happens if a customer doesn't have a default pricing package and there are more than
one "Public" pricing packages. Please read the Pricing topic for more information.

Login |
% Password |
Languane |English ﬂ
Pricing |Standarl:| j
w.
Cptions = | K | Cancel |
Choose package. ..

Protect terminal

You can use the following features to secure your terminals:

m Hide Windows Start button
m Hide Taskbar

m Hide Desktop items

m Disable Task Manager

m Disable Registry Editor



m Hide Tray items

m Hide Log Off

m Hide Shut Down

m Hide Run

m Disable Control Panel

m Disable Windows hotkeys

Hide drives

m

TrueCafe 4.6.1011.30. Logon (Serge)
Login I
% Password I §
Security
Language |Eng|ish
[v Hide Start button
Options << | Enter | v Hide Taskbar
| Hide Desktop items
Server IP |192. 168.2.1 |+ Disable Task Manager
Connect | |+ Disable Registry Editor
v Hide Tray items
Background I I Hide Log OFF
[~ Hide Shut Down
[~ Hide Run
[~ Disable Control panel
[~ Disable Windows Hotkeys
Programs

If you assign a terminal profile to a terminal, then a tab set with the applications is displayed. Double-

click on any icon to start the application:




TrueCafe Client

- Games | Media
Login smith l ]
Mame John Smith
iy
Fricing Standard MW
; FIFA MNFS Mosk
Pavment Pre-paid \Warted
) Top-up... | Pre-paid 1.50 . 0 9
Q Order.., Tirne 0:00 ] Counker Strike Dioarn 3 Quake 4
Traffic ]
Chat, .. Others 0
% 2 " “ .:I :'J
&, Passward. .. Tax 0 4 a
Call of Dty 5.T.ALK.ER. FarCry
Total 0
Balance 1. 50 E E
- time left: 0:15 | Cybercafe Yalume
Rules

Hold Shift button when you double click on a program icon to start the program via "Run as...

(administrator)".

Warn before session is finished

When a customer session has a critical amount of time/money left, a warning dialog is displayed and/or
a warning sound file is played. Use TrueCafe options to select your sound files to be played or specify
whether the warning dialog must be displayed.

Warning E'

& time left: 0:0%

Contact the operator if you are going to extend
Your Session.

Printing confirmation

If the corresponding option is enabled, the confirmation dialog with pages/charge information is
displayed when a customer prints a document.

TrueCafe Client

A Documnent Microsoft Word - Docurment 1



= Pages 9

0.20 $

Are vou sure vou wankt to print this document?

Mo |

Order drinks/snacks

Customers can order goods, drinks, etc. from computers where they sit. They select an item in the list
of services you configure in pricing.

You can disable the "Order" button in TrueCafe options.

Order, b_<|

ame Price
ZD-R burning 1.00
Juice 1.00
Prinking 0.05
Scanning 0.05
Snack. 3.00

tent)

o ] [ comeal |

End session (log off)

A customer can press the "Log Off" button to end his session and lock the terminal. The terminal is
locked as well when a cyber cafe operator remotely ends the customer session in TrueCafe
Administrator.

Use TrueCafe options to utilize the next log off features:

1. Close all running applications in order to prevent any private customer data from further browsing by
the next user.

2. Clear Internet Explorer Temporary Internet Files and History.
3. Log off a session when a customer make Windows log off or shutdown.

4. Log off a session when a screensaver starts.

Run log on/off script

Run external programs when TrueCafe Client logs on/off. You can use customer_id, terminal_id,
pricing_package_id command line parameters, which are replaced with actual values when the
script is called.

Specify script command lines in the options






Reports

TrueCafe Reports provides 4 reports: customers, services, sessions and events. Each report is time-
dependent, so you have to enter a start and stop dates (or check the "All time"). Press the "Refresh"
button to run a report.

You can export any data table to Microsoft Excel for further analysis. by click on any data grid and

pressing Ctrl-E hotkey.

Customers

m Customers (the main list).
m Balance operations (dependent).

m Services provided (dependent).

m Sessions and jobs (dependent).

% | TrueCafe Reporis - [Clients] [’._|[’E|[E|
Q Help - 0 X
a since |:| unkil I:I [#] All Time i3 Refresh
Clignks Search | |
@ Feqg. Date 10 Mick Current balance |Last Mame |First Mame [Middle Mame |Created by |Deleted? M
1j1fz002 2 |(anonymans )
Services 1/1fz2002 3 Adm 0 syskem
afafzooz 5 |Operakaor 200,00 Adm -
w 311012005 & Smith 0 | Smith John Adm
S 112002 4 Somebody 1] system
Visits =
Balance changes Wisits
Datke |Change |Changed b | L Drake |Name |Eia|an-:e |F‘ai|:| money|Created by | A
Sl » o ||_|3124/2005 12:47:17 I {anenymaus) [LOCAL 0 152.10 Adm
] 3/24/2005 2:53:34 Pl{anonymaous) [Skakior 1] 133,40 Adm
Services __|3i24/2005 2:54:09 Pl{ananymaus) [Statior 0 139.50 Adm —
HETE |,|:|,|-|-,.;.|_||-,|; |Llr|it |T.;.|;a| Cosk | A || P|3[25/2005 1:17:12 Pl{anonymous) [Statior 0 15.62 Adm
b Jice 40 glass 400,00 _3,1'25,!'2["]5 210903 Pl {anonymous) [LOCaL 1] 10,90 Adm
Prinking 20 shest 5.a2 ] 3/25/2005 3:09:07 Pl{anonymous) [Statiorn 1] 0 Adm 3
_Time 37983 minute . 3697.57 ) — 7 =
@ Traffic 500 Khyte 0 Jobs Tatal Wisit Cosk 15.62
Service |'-.-'-.-'u::rkstatiu::n |.ﬁ.m|:u_|nt |Llnit |Di5cu:uunt|Tu:utaI Cask |Start | G
lTimE #5kation 3 161 minute 3 15.62 3/25/2005 1:
_TraFFic #5kation 3 500 Kbyke 3 0 3/25/2005 1;
v
+ | Total money paid by client 4103.40
Zkrl-E - export of active grid data to M3-Excel

Services

Services (main) and customers (dependent).



£~ TrueCafe Reporis - [Services]

@ Help
3 since |:| unitil |:| [v] all Time i Refresh
Clients Services Service Per Clients
Marne |F'.m-:n.|nt |Llnil: |T|:|I:al Cl:nst| e Sl | |
|-k burning 1 |ikem 0
Coffes 1 item o Mick amount (Uit |Tokal Cosk | #
Services — PO S N RN
Juice 244 glass 1924.00 | 2 (anonymous) | 39510.00 (minute | 5540,37
Prinking 47 |sheet Adm 18.00 |minute 1.80
w _Snack 3 ikem Smith 145,00 minuke 14.44
isits 4 Somebody | 36306.00 minute  3623.67
i Traffic 500 Kbyke
Events .
¥
Taotal Cost a852.34 v
Ckrl-E - export of active arid data to M3-Excel

Sessions (main) and jobs (dependent).

£ TrueCafe Reporis - [Visits]

@ Help

8

Clignks

Services

B[(=]eS

=1

Visiks
Date |Client |Name |Balance|F‘aid mmoney |Created by | *
& 3/2512005 3:58:35 P (anonymous) (anonymous) [Skation 3] 0 0,20 Adm
b 3/25/2005 3:58:40 P {anonymous) | {anonymous) [Station 1] n 0.20  Adm
3,!'25,!'2["]5 4:14:51 P Adm Adm 1] 400,10 | Adm
(= (anonymaus) | (ananyrmaus) [Skakion 3] 0 201.70 |Adm
i 3,1'28,1'2[![!5 4:39:55 P {anonymous) | (anonymous) [Skation 3] 0 200,00 | Adm
| 32812005 4:46:56 P Somebody | Somebody 0 0.62  Adm H
_ 32812005 4:.57:43 P Adm Adm [Skation 2] 1] 201,50 |Adm
M
Jobs Tokal Wisit Cosk 201.70
Service |'-.-'-.-'u::rkstatiu::n |.ﬁ.m|:|unt |Llnit |I3|isu:u:n_|nlzJ e |T|:|tal Cosk  |Skart Ea
L Juice #5tation 3 20 glass u] 200,00 2005,03.25 4:30:26 PM
] Tirme #5kation 3 17 ‘minuke ] 1.70|2005,03.25 4:30:26 PM ==
bt
Total money paid For visits 8852 82 Cash 906312
Total balance changes 210,30

Zkrl-E - export of active arid data to M3-Excel

Events




System events:

m Servers

tate is changed.

m Terminal state is changed.

% | TrueCafe Reporis - [Evenis]

@ Help

8

Clignks

Services

[Date Ewvent

[ 1/24/2005 4:43:19 PM
1/24/2005 4:43:59 PM
1/25/2005 12:53:36 PM
112502005 1:17:36 PM warking
1/25/2005 1:25:38 PM

|F‘arameter |
nok responding 127.0.0.1
not responding 192.168.0.3
server skarked
127.0.,0.1
nok responding 127.0.0.1

[>

|

krl-E - export of active grid data to M3-Excel




Web Reports

Analyze your business data in your web browser. Get access to your cyber cafe activity information
outside the cafe from the Internet. Browse session, customer, service, terminal, etc. data for any period
of time. View the diagrams which represent your business growth. Print any report on your printer for

further analisis.

TrueCafe Web Reports is based on ASP.NET platform which means it requires Microsoft .NET framework
3.5 or later installed. Web Reports installs UltiDev Cassini Web Server which hosts Web Reports

application.

Download Microsoft .NET framework

Download TrueCafe Web Reports

Start Web Reports from TrueCafe program group:

ﬁ Database Wiorkshop
Documentation
Readme

Reports

Server Manager
TrueCafe

Uninstall

Printer Watcher Config
W'eb Reports

P e . o= B G (0 G

TrueCafe Web Reports

Locegn

Pasyword

Laogin



http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=262D25E3-F589-4842-8157-034D1E7CF3A3
http://www.truecafe.net/download/TrueCafeWebReports.zip
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Navigation

Each report contains the header navigation pane which allows you to switch back to the main menu
page, log out from Web Reports or select a period (today, yesterday, this week, last week, etc.) to
display.

TrueCafe Web Reports

Manu Lodpou,

9 Top-up (Today - 5/28/2007)

| Today '-: Refresh

Report: Today

Displays today sessions, top-ups and services.



Top-up $82.00

Post paid £0.00

Total $82.00

Promatian 50,00

Sessions

mm_m__ Falance [Minates [Amount [Paia [Rocomt
B8 SIGR00T 24320 M $0.00 0 5000 $0.00

B8 SQER00T 24318 PW mm.mmw $15.00 5| 3050 50,00

80 SEEL00T 4T 24 PW S2ER007 35424 P Customer 002 | Terménal 3] 53000 5 $0.50 50,00
| | [l stoofsen] |
Tﬂp =up

m_mmm
20 SFER00T 347G PM Customer 004
T SOED00T 24721 PM Customer 004 ﬂn.nn

72 SOER00T T47.26 P Customes 002 $5.00
23 SOBR00T T47-31 PM Customer 002 $5.00
B4 SOBE00T T47.54 M Customes 002 $10.00
5 SROBE00T 347:58 PM Customer 002 $10.00
6 SOEE00T T4T.44 B Customes 003 $2.00
27 SOBR00T T4T-47 PM Customer 003 $5.00
6 SMOEE00T 34750 P Customes 003 $5.00
2 SOBE00T 347-53 PM Customer 003 $10.00
30 SOEE00T 4757 B Customes 003 :m.m
| SOBR00T 34800 PM Customer 003

Services

10 miute 5100

Report: Totals

Displays sessions, top-ups, promotional top-ups, services, etc. for a selected period. Income = top-up +
post-paid.



—mmmm

BO% $A74040 396117 $TA1446 0109 $AME3S
m I M0T5985  BBAGET RTIZO2  $E12.50 $10,385 85
March 14522 PIIBI241  BEOBTS B TEIE B S0 $1254002
Apsil 12581 H4191 38 | $220574 WA STEI06 1208244
My B $EEIEI  $2MB0 $TSETE $IS00  ETHNTR
June i} $0.00 $0.00 $0.00 $0.00 $0.00
Juby Li] 000 000 000 #0.00 #.00
August 0 00 000 000 S000 $000
Seplember 0 000 $000 $000  $000 000
October L1} $0.00 $0.00 $0.00 $0.00 #0.00
Hovembrer Li} $0.00 $0.00 $0.00 #0.00 #0.00
Decembrer a

0,00 $0.00 30,00 $0.00 #0.00
| eoulswsisal ssionlsnonn] aansliosss

Sessions

Jam Feb Mar Apr May Jun Ju  Aug Sep Ot Mov Dec

Income

Jan Feb Mar Apr May Jun bl Aug Sep Ood Moy Dec

Report: Customers

Displays customers with login, name, balance, etc.

o [oate _[Delete dateJLogin____[Hame [Payment[Pricing __[Balance|
17 S[AR007 T46:55 PM Customer 001 post.paid (ropacksge) $14.50
18 S/2AR00T T47.02 PM w post.psid (ropackage) 32950
19 S{EE00T 34740 PM posl.psid (r packsge) mm

I___--_

Report: Tickets

Displays tickets with login, face value, balance, etc.

10 THR000E 25252 PM 11 000 .:.m,m..s]
11 702008 25252 PM 1 Standard mm $0.00 (anorymous)
12 702008 25252 PM 12 Stardard 000 000 (ancrymous)
13 TVR02008 25252 PM 11 Stendard $2000 000 (snorymous)
14 70008 25252 PM 14 Stardard $2000 3000 (sncrymous)
15 702006 25252 PM 15  Standard 000 000 (anonymous)
16 702006 25252 PM 16 Stardard 000 000 (ancrymous)
T TR02008 25252 PM I Standard $2000 3000 [snorymous)
B TURO00E 25252 PM 1 Slarddard mm 000 (ancrymous)
8 TV2005 25252 PM $0.00 (anorymous)




Report: Top-up

Displays customer balance top-ups.

0 [pate ____|Customer _[Amount [Promotion|Comments|
20 SEACOOT TATE PM Customes 041 $5.00

21 SCAQ00T 24721 PM Customer ¢4 $10.00

22 SEACOOT TAT:28 PM Customer 042 3500

23 SOR200T 34T PM Cuslomer 02 3500

24 SEAC00T 34T PM Customes 042 310000

25 SMEO00T T4AT:3EPM Customer M2 $10.00

26 SEACNNT TAT44 PM Customer 043 $2.00

27 SERONT TATAT P Customer 043 3500

28 SEEO00T TATS0 PM Customes 043 3500

20 S{RO00T TATSIPM Custemer 043 $10.00

30 SEEC00T TATST PM Customer 043 310000

31 SERO0T TA500 PM Customer 043 3500

32 SEEO00T & 223 PM Customes 083 3500 Promation
33 SMRO00T £:2320 M Customer 42 $10.00 Promotion

Report: Sessions

Displays sessions: open / close dates, starting balance, minutes, amount, post-paid and whether a
receipt was printed.

) T T ) T T T

B SE00T 24320 PM 0 000 $000
B SZACOOT T4 18 PM SEAC007 35421 FM w.ﬂ :Hsm 5 3050 3000
S0 SZE00T T4%24 PM SZA00T 35424 PM Customer 802 [Termingl 3] $30.00 5 050 $000

Report: Services

Displays services: units and amount.

D_EEEEIM

B em

1 Hem ﬂ.ﬂ

1 #em 2005

1 Hem 005

2 fem 5 100
32T mirde  $2023

IE[EF

a8
4
3
&
5
1
N

Services

[ B5% Tim=
B 6% Coffes
[ 14% Srack
W 3% Others

Report: Terminals

Displays terminals: name, IP-address, minutes and amount.






ofoate __ Jociete dateJuame ____Jip ______ [Minutes)

1 AR 002 120000 AM Terminald 19216816 5
2 NI 111358 AM Terminal 2 (XF) 152168 20010 14 !‘l-‘l:l
N0 E00Z 1042 34 AM T_H.!I:IlIllL! 1921681 3 5 §0E0
B EA2E002 123545 PW 1921681 & 03 $2583

Web Reports Access

An operator has to have the "Reports" option enabled in order to login to Web Reports:

Customer, i'
Logon Reports I
Create Edit Delete
Cuskomers ]
Tickets ] F I
Services Fi F] ]
Terminals ] F] ]

How to open Web Reports over the
Internet

When you connect your TrueCafe Server computer with Web Reports installed to the Internet, the
computer usually gets a public IP address (e.g. your ADSL or network router is assigned with a public IP
by your Internet Service Provider, ISP).

There are 2 problems regarding this:

1) the IP address is dynamic so you don't know the exact current IP of your WAN router when you
connect to your network from the Internet. You can either ask your ISP to give you a static IP, or use
some service such as no-ip.org to use the computer host name instead of numeric IP.

2) your server computer is behind your router so you can only connect to your router from the Internet,
not your TrueCafe Server computer. In such a case you need to setup port forwarding on your router to
direct the corresponding requests to your TrueCafe Server computer.



Web Reports by Email

You can use free email providers such as Gmail, Hotmail or Yahoo Mail with your TrueCafe Web Reports.

Gmail

Set Address = smtp.gmail.com, Port = 587, Enable SSL options:

Mail server

address |smtp-qmail-cnm |
Fort{SMTF)

User myemail@gmail com |
Password | |

Enable S5L

Hotmail

Unfortunately you have to login to Hotmail website before sending any emails, which makes this
inconvenient for any email subscription, but anyway...

Set Address = smtp.live.com, Port = 25, Enable SSL options:

Mail server

Address  |smtp live.com |
Port{SMTF)

User |myemail@hotmnail .com |
Password | |

Enable S5L

Yahoo Mail

You have to sign up for Yahoo Mail Plus in order to be able to use their SMTP server. Unfortunately we
don't have such a subscription at the moment so please let us know if you have a chance to try it out.
Thank you in advance!



Printer Watcher

Printer Watcher automatically charges customers for printing on any printer in your cyber cafe. You can

charge black-and-white and colour printing using different rates.

Install

Install Printer Watcher on a computer with a printer connected:

e Setup - TrueCafe

Select Components " J
Which components should be installed? (7 /
o

Select the components you want toinstall; clear the compaonents you do not want ko
inztall. Click Mest when you are ready to continue.

| Cuztan installation

rver, Adminiztrator, Beports
[] Client [locks workstation!|
[ ] Traffic Meter required for traffic calculation, install it on serser]

0.5ME
0.5 ME

[ Printer watcher [install it on a computer with a printer to charge printing] 0.7 ME

Current zelection requires at leazt 4.5 kB of digk space.

< Back ]L__ge:-cb l [ Cancel

Start Printer Watcher Config application from TrueCafe Start Menu program group, enter TrueCafe

server IP address and start service if it is stopped:

“% Printer Watcher Configurator, E||§|[Z|

Server IP address Part:
192.168.0.1 | | |

Restart service to apply changes

Skatus

Running

USB or Network printer?

USB printer: install TrueCafe Printer Watcher on the computer where your printer is connected to.

Usually it makes sense to connect your printer to your TrueCafe Server computer.



Network printer: install your printer as a local one on the TrueCafe Server computer with Printer
Watcher installed. Specify the MS Standard TCP\IP port with the printer IP address as the port of the

printer. Every computer should connect to the printer via your server, e.g.

\\ServerName\PrinterName.

Configure

1. TrueCafe main menu > View > Print Jobs :

see it in the list.

print a document on your printer and make sure that you

The documents are highlighted depending on the document's state: not charged document background

is painted in grey, cancelled document font - in red.

< Print Jobs

=

Lg;" Refresh | [ Export ko M3-Excel ] [ # Cear ]

Date

|C|:|m|:|uter |Llser |F'rinter

|Du:u:ument

|F'a|;|es |Cnpies |C|:|I|:|r |Cnmments L

126.12.2006 TERMIMNALL
26, 12,2006 | TERMIMALL
26,12, 2006 | TERMIMALL
26,12, 2006 | TERMIMALL
26.12.2006 | TERMIMALL
26,12, 2006 | TERMIMALL
£6.12,2006 TERMIMALL
26.12.2006 TERMIMALL
26.12,2006 TERMIMALL
£6.12,2006 TERMIMALL

| #

Guest
auesk
Guest
Guest
Guest
Euest
Guest
Guesk
Guest
Guesk

SERVERMHP Laserdet 5L

SERVERYHP Laserlet 1020

SERVERVHP Laserdet 5L
SERVER\HP Laserdet 5L
SERVERMHP Laserdet 5L
SERVERYHP LaserJet 5L
SERVERVHP LaserJet SL
SERVERHP LaserJet SL
SERVERVHP Laserdek SL
SERVERYHP LaserJet SL

Microsoft Word - Letter
Microsoft Waord - Letter
Microsoft Word - Letber
how o conguer the wiol
htkp: /v neves, com/
htkp: /s microsoft .o
hkkps s, ricrosoft, o
Microsoft Word - Letter
Microsoft Word - Letter
htkp: /e yvoutube, oo

2
£
Z
Z0

1
1
1
Z
2
1

1
1
1
1
1
1
1
1
1
1

Mono: Accepted: #101, Cuskomer 1
Mono: Can't find a pricing for the prinke
Monog Cancelled: #102, Customer 2
Monog Cancelled: #101, Coskomer 1
Mono: Accepted: #102, Cuskomer 2
Mono: Accepted: #101, Cuskomer 1
Monod Can't find a terminal with the ne
Monod Can't find a terminal with the ne
Monoo Can't find a terminal with the ne

Mono: Can't find a terminal with the ne

|
|

Close

2. Make sure that the value in the "Computer" column in the "Print Jobs" list meets the ip address or

name or "computer name" of any of your terminals.



X

Terminal

General |Extra | wirtual |

Marne |GameF‘|:|int1 | @

Camputer name |GF‘1 |

(if differs From the name abowve)

IP address
(%) Static 1192.168.100.1 |

O Crynarnic

MAC | |

I Ok l ’ Cancel

3. Specify page prices, TrueCafe main menu > Setup > Print billing :

P )

Print charge

Install PrinterWatcher on your print server and print a document to see your
printer in the list

’ £ Edit... H 2 Delete ]

Printer B/M page, § Colour page, &
SERVER\HP LaserJet 5L 0.05 0.05
Print firewall

Blodk printing if there is not enough maney on the customer's balance

Printing confirmation

’ % Print Jobs... ] ’ (Z) Help ] k Close i

Charge

When a customer prints on a printer that is being monitored by Printer Watcher, he/she is automatically
charged for printing:



Session [zl

’ [ Mew... ] ’ B Edit... ] ’ " Finish ] ’ X Delete ]
SErvice |Wnrk5tatinn|.ﬁ.mnunt |Llnit |Disu:|:uunt |C|:ust |Tax |ﬁ
_Time VIP 2 0:46 |minute 1.53
Traffic fStandar WIE = [ khutke [l
Frmvea— 1o ko o] ol
¥
<) >
Balance ICI Money Ijl Pre-paid 0
Start |2,|'26,|'2IZIEIE- 12:09:35 PM | Time 0:46 1.33
Traffic 0
Mame |{annn';.-'mu:uus]l [VIF 2] | Others 0.50
Surm 2,03
Client |{annn';.-'mu:uus]l | s 0
Discount | {no discount) v | Tosl 2.03
3 Refresh To pay 2.03
Zhange
= s
|:| Prink receipt

Printing confirmation

When this option is enabled, TrueCafe Client displayes the pages/charge information dialog when a
customer prints a document. A customer can then accept or decline the printing.



Print firewall

Stop printing on any printer in your cyber cafe when not enough money left on a customer's balance.

When a customer sends a document to a printer, TrueCafe calculates the document pages/copies and

amount charged. If the customer doesn't have enough amount on the balance, the printing is stopped

and a warning message is displayed on the customer's terminal.



Web Access

Sell tickets and top-up customer accounts remotely from your web browser.

This is useful when you have an operator who sells tickets/tops up accounts from a separate computer
(e.g. hotel reception) and doesn't have access to your TrueCafe Server computer.

TrueCafe Web Access must be installed on your TrueCafe Server computer. Use Web Access Windows
Start menu shortcut to run Web Access. Copy the address to your remote computer and replace
127.0.0.1 in the address with your actual server IP address.



{= TrueCafe Web Access - Windows Internet Explorer

G- &

127001

MR

3| X

] [E2E

5 Setup - TrueCafe

Select Components
Which components should be installed?

Select the components you watt ta install; clear the compol
install. Click Mest when you are ready to continue.

| Custom installation

Server, ddministrator, Reports
[ Printer ‘W atcher (install it on a computer with a printer g
[ Client (locks this computer)

Current selection requires at least 9,9 ME of dizk space.

¢ Back

e Favarites (& Truecafe Web Access - 8 fs - Page - Safety - Tools~
i
TrueCafé Friendly Cyber Cafe Software
.
S TrueCafe Web Access
myCyberCafe
adm logout
Select ticket walue
Al zO
ket 05|
Name Balance Ticket Action Customer
(=1 3 Adm $0.00 o) &
(=] 4 Somebody $0.00 Lagin  smith
(=) 5 Operator $0.00 Mame John Smith
{=) & smith John Smith $20.00
=y 7 7 Ticket £20.00 $20.00
(=3 & 8 Ticket $20.00 $20.00
=3 2 0 Ticket £20.00 $20.00
=} 10 10 Ticket $0.00 $z0.00 =Zell
=1 11 11 Ticket $0.00 $z20.00 =Zell
=1 12 12 Ticket £20.00 $20.00
=1 13 13 Ticket £20.00 $20.00
=1 14 14 Ticket £20.00 £20.00
=) 15 15 Ticket £20.00 $20.00 .
(=) 33 Operator 2 $0.00
{1 39 test £50.00
12
b,
€9 Internet Sh v H1o0%

Club map

Setup the info display at your shop or cafe receiption so that an incoming customer can locate an

available terminal himself.

Click the Edit link to change options and move the terminal icons on the map. Upload your club map

layout picture.




O

{= Club Map - Windows Internet Explorer

6@!' |g, http: flocathost: 40717 TrueCafeebyClubMap, asp=Pmode=edit ||§||E||E| |P '|
'i‘j-Favorites |gClub Map _| ﬁ - B @ * Page v Safety » Tools =
o~
My Internet Cafe at 2/15/2010 3:08 PM
View Available
Edit terminal
Admin
Terminal 1 Terminal 4 Terminal 7
Terminal 2 Terminal 5 Terminal 8 )
Terminal 3 Terminal 6 Terminal 9
Room 1 Room 2 Room 3
Options
Refresh interval seconds
Background picture | |[ Browse.. | =
2
Dane €D Internet Gy v Hi00% -

Requirements

TrueCafe Web Access requires Microsoft .NET framework 2.0 or later installed. Web Access installs

UltiDev Cassini Web Server which hosts Web Access application.

Download Microsoft .NET framework


http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=262D25E3-F589-4842-8157-034D1E7CF3A3

Thin Clients. NComputing and Windows
Terminal Server Support

You can setup TrueCafe on a thin client multi-session platform such as NComputing host
(www.ncomputing.com) or Windows Terminal Server. In this case a number of user sessions run on a

host computer simultaneously. Each session is considered by TrueCafe as a separate virtual terminal
with TrueCafe Client running. TrueCafe Server can be installed on either the same shared computer or
a detached one.

TrueCafe works well on NComputing, Windows Terminal Server, Elusiva, Sunde.

Setup

1. Install TrueCafe Server on a server computer. It can be your multi-session host computer.
2. Add virtual terminals (use main menu -> Terminals):
Name: it's up to you

IP address: IP address of your multi-session host computer. It should be the same for all virtual
terminals.

User name: user name which is used to logon to the terminal ("Terminal client login name" for
NComputing setup). You can see user names in Task Manager -> "Process List" tab (Show processes
from all users) -> "User name" column.

= Terminals

Terminals | Praofiles

[ [ Mew... ] [ A Edit... ] [ 32 Delete ]
Mame Computer name || IP address rofile Ilser name M
b
Terminal 2 MC Hosk 192.165.0,100 |no profile) | userz
Terminal 3 MC Hosk 192.165.0,100 |no profile) | user3
bt
<l >

Close



http://www.ncomputing.com/

Terminal [Z|
zeneral | Extra | Yirtual |
User name |user1 |

IJse this field if you run a few virtual kerminals on the
same server (Windows Terminal Server, NComputing,
ek,

(] 4 l ’ Cancel

3. Install TrueCafe Client on your host computer. Logon to the host computer under your administrative
user account. Run TrueCafe setup and install TrueCafe Client. Restart the host computer. This will
automatically start TrueCafe Client for any terminal user session then.

4. Login on your terminal (e.g. NComputing box). Press the "Options" button on TrueCafe Client login
window. Enter a valid server IP address (IP address of the computer where TrueCafe Server is running,
it could be the same multi-session host computer where TrueCafe Clients are installed).

Longim |
% Passward |
Language |Engli5h j
Options == | Enter |

Server IP 192,165.0.100 I

Background |

Dial-Up | |

Cptional, Selected dial-up connection is being
connectedfdisconnected when cuskomer is logging
onflagging off.

5. Enter a TrueCafe user name and password to logon. You can use default adm/adm user
name/password after the first installation.

NComputing setup samples

1. All-in-one

NComputing host is used for TrueCafe Server and Clients. Operator is working on the same host as



customers do.

Use 127.0.0.1 or host IP (e.g. 192.168.1.1) for all IP options on the server and client sides.

Customers
User
MComputing host Operator
User2
192 168.1.1
TrueCafe Server
User3 TrueCafe Clien

Server side settings:

Terminals

Terminals | Profiles |

’ [ mew... H & Edit,., H € Delete ]

Computer name

| 2 Terminal 1
Terminal 2

Terminal 3

|

Client side settings:



TrueCafe. Logon

Login |

Password |

Language |Eru;||i5h ﬂ

Options <<= | Enter |

Setver IP

Background |

Dial-Up | =]

Cptional, Selected dial-up connection is being
connectedfdisconnected when custamer is logging
onlogging off.

2. Detached operator/server computer

A separate operator/server computer is used with TrueCafe Server installed. TrueCafe Client is installed
on NComputing host.

Customers
User1
MComputing host Operator
Metwork
User2
1892.168.1.1 192.168.1. 100
TrueCafe Cliant TrueCafe Server
User3

Server side settings:



Terminals

| Terminals pr.;.ﬁ|es|

’ [ Mew... ] ’ £ Edt... ] ’ 32 Delete ]

Marme Complker name IP address ser name  f#
|2 Terminal 1 HST1 192.168.1.1

Terminal 2 Hi25T1 192.165.1.1 usere

Terminal 3 HO5T1 192.165.1.1 user 3

¥

) >

Close

Client side settings:

TrueCafe. Logon

Login |

% Password |

|Eru;||i5h ﬂ

Language

Options == | Enter |

Setver IP

Background |

Dial-Up | =]

Cptional, Selected dial-up connection is being
connectedidisconnected when cusktomer is logging
anflagaging aff.

Issues

Since TrueCafe Client auto-starts for each user on your thin client host, you may need to disable this for
some users such as administrator. It can be accomplished by applying a special registry file which we
send to our registered clients.



Wireless Billing

Simple Setup

(Step-by-step simple Wi-Fi billing setup guide)

Introduction

Wireless billing allows you to charge the customers of your cafe, club, shop, hotel, etc. when they
connect their laptops, PDAs or any other mobile devices to your access point (Wi-Fi hotspot) and use the
Internet to surf the web, read emails or chat via an instant messenger.

When a customer first try to surf the web, TrueCafe detects the connection and redirects it to the
TrueCafe Wi-Fi billing login page. The customer uses his or her login information (printed e.g. on a ticket
you sell, on a receipt of your cafe, etc.) to start a session. When the balance is over, TrueCafe blocks
any connection from the corresponding customer terminal.

In order to provide the wireless billing you have to install TrueCafe Server on your Internet gateway
computer (Windows OS is only supported). The gateway handles all network connections from your
customer terminals.

wired terminals

- _\_,.—\_A-u—\____\ﬂ_\

S & LAN, Wi-Fi \—}, -=

- A
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]

L wireless terminals
Intenet gateway

TrueCafe Server

We recommend the following approach... There are 2 network cards (NICs) in your Internet gateway
computer - NIC1 and NIC2. NIC1 is connected to the Internet (WAN) via xDSL/ADSL, Cable, etc. NIC2
is connected to your LAN: Wi-Fi access point, hub, switch, etc.

Use Windows Internet Connection Sharing feature in order to make a bridge between NIC1 and NIC2.

You can use direct Internet connections or proxy 8080 connections as well.

Setup

Setup Internet Connection Sharing between the network cards on your Internet gateway (server)
computer. Your WAN-connected network card (NIC1) has IP address usually provided by your Internet
Service Provider. Your LAN-connected network card (NIC2) obtains some internal IP address, most


http://support.microsoft.com/kb/234815

often 192.168.0.1.

Read more about how to setup Internet Connection Sharing

Your Wi-Fi access point uses DHCP to assign a dynamic IP to a customer's wireless laptop when it's
connected. Access point gateway IP setting is your NIC2 IP address (192.168.0.1).

Please make sure that you have your wi-fi router NAT feature disabled. Otherwise all your wi-fi
terminals IP addresses are translated into the single router IP address on the server side.

If you use a router in your LAN, it's gateway has to be your NIC2 IP address as well (192.168.0.1).

wired terminals
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TrueCafe Server

You don't have to add your wireless terminals on the TrueCafe server side manually.
TrueCafe automatically adds a new terminal when a customer successfully logs in.

Use TrueCafe Wi-Fi options screen to select your NIC2 adapter and enable the Wi-Fi billing feature (main
menu > Tools > Wi-Fi...):


http://support.microsoft.com/kb/306126

< Internet, URL , Wi-Fi

Select a network adapter which connects vour server computer
ko wour cuskamer kerminals:

Adapter | Local Area Connection 2 (192.163.0.1) w
TrafFic

Incoming trafFfic

Cubgoing kraffic
JRL log

URL log
Exclude |.I:|m|:| .gif .jpg .jpeq .png Ljs .oss Lico
Wi-Fi

Wi-Fi billing

’ @ Help ] I (] 4 l ’ Cancel

Run!

When a customer comes to your cafe, shop, hotel, etc. and connects to your Wi-Fi access point, it
assigns a new dynamic IP address to the customer's wireless laptop.

Then the customer tries to browse the web and since he or she hasn't been yet logged in, TrueCafe
Server redirects him/her to the login page.

The customer logs in using a ticket purchased or a member account and then is able to surf the web.
On the TrueCafe server side you see that a new Wi-Fi terminal is added.

In order to view the session info such as the balance or time left in a web browser, the customer types
your gateway computer name in the browser address bar (e.g. "gate" on the screenshot below).

The customer can log off from the session info page. You can also stop his session from the server side.

When the customer balance is over, TrueCafe automatically stops the customer session and blocks any
connection from his wireless terminal.
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Customize login page

If you have some HTML experience, you can customize your Wi-Fi login and session info pages. Edit the
login.html and info.html files which are located in the TrueCafe\web folder.

Wi-Fi session timeout

Stop a Wi-Fi session automatically when it's inactive for a few minutes or a customer leaves your shop
not logging out.



Wi-Fi white list

Specify wireless billing exceptions: website names or terminal IP/MAC addresses. For example, you can
add your employees' laptops addresses here so that they have free access to the Internet. It makes
sense to specify your network printers IP addresses as well so that wireless billing doesn't stop printing.

Internet, URL, Wi-Fi

Select a network adapter which connects wour server compuker
ko wour customer terminals:

Adapker |L|:u:a| Area Conneckion 2 (192,168.2.1) b

TrafFic
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Eandwidth management
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Proxy servers

You can use Wi-Fi billing with a proxy server. The following proxy ports are supported: 8080 and 3128.

Login page: your cafe logo

Replace the logo.gif file in the TrueCafe/web installation folder with your cafe logo.
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Valve Steam Support

TrueCafe supports Steam (Valve Corporation), which is a content distribution system often used by
cyber cafes to play computer games:

Conruniky Wy games Wy medi: Tools

Games Status & Metascore Developer

= IMSTALLED
BestGameEver
¥alve
¥alve
Introversion Software
Team Garry
¥alve
Yalve
Yalve

Yalve

(A} Half-Life 2: Episode Two o - Ready ¥alve
(&Y Half-Life 2; Los st o - Ready Yalve

Half-Life Deathmatch: Source e - Ready Yalve
Half-Life: Blue Shift - Ready 71 Gearbox
- Ready Yalve
- Ready 75 Eidos
Multivinia Demo %o - Ready Introversion
ddwaorld: Abe's Exoddus Demo % - Ready Oddworld Inhabitants
rnnsinn Frrre %, - Ready Gearhnx

Add non-Skeam game. ..

More about Steam in Wikipedia

Setup

The most usual approach is to setup a separate Steam account for every game you provide for your
customers in your Internet cafe.

Then you register your Steam accounts (login/password) in the TrueCafe CD-key management system
and create a shortcut to your game on the TrueCafe Client program panel.

When a customer double clicks on a game shortcut, the CD-key management system takes an available
Steam account from the stock and use it to start and login Steam.

More on the CD-Key management system

1. Add Steam Accounts

Open TrueCafe main menu > Setup > CD-keys and add your Steam accounts to the list in the

following format:


http://store.steampowered.com/
http://en.wikipedia.org/wiki/Steam_(content_delivery)

login=steam_login password=steam_password

(login and password must not contain spaces)

B=1E3

[ [ new... H @ Edi... ][ 3¢ Delete ]

[ [ new... H & Edt... ][ 3¢ Delete ]

s

_|Half-Life: Counter-5trike

| | Lord OF The Rings: Rise OF The
| | Lord OF The Rings: The Battle Fan
| | MNEA Live 2007

| | Meed For Speed: Carbon
_|Meed For Speed: Most Wante;
| | Meed For Speed: Underground 2
Cuake 3

Quake 4

F_
Unreal Tournament 2004

[ E Applications. .. ]

Game

Marme

Mame IKeys I % D IKey I
_|FIFA 2005 0 | | 7 [login=IJ3ER.1001 password=12345
| | FIF& Manager 2007 0 L & login=IUSER 1002 password=123456

|Steam

D Reqiskry
{(*) Command line

|-I|:u;|in %ologin %epassword

Ok ] [ Cancel

2. Add Game Shortcut

Add your game to the corresponding application profie 'main menu > Setup > Terminals > Profiles tab .
Specify the path to Steam.exe (it's usually C:\Program Files\Steam\Steam.exe) and select CD-Keys =

Steam:




Terminals

Terminals | Profiles |

[ [ Mew... ][ A Edit... ][ 3¢ Delete ] [Baesign...]

Marne Lo

| 3 Game Station = |
Internet Skakion 500 350 =
=

Applications Alkernative
[ D Mewt, .. ] [ A Edit... ] [ 9 Delete J D ey

Tab Mame Public |CD-keys Path A | Terminal
1 .Games ;
| ©Sonfig Zontrol Pang
| Config Reqgistry Edi Application
Zanfi Services
— d Tah |.Games |
Games Counter Sk
_|Games Cybercafe Bl pame |Call of Dutyd |
Games Daarm 3
| =ames FIFA Public
e et I
_|imames enerals CD-kevs |Steam = |
Games GTA
_|Games Heroes 3 | path |C:1Prngram Files!,Steam! Steam. exe | Tl
e (] )

x‘ 5:-'|~.f| 1EIEI| E

Comments

L Ok J [ Cancel ]

3. Start Game

When you start a customer session on the terminal, TrueCafe Client displays your Steam game
shortcut. Double click on it to login to the Steam account:



TrueCafe Client

Games lCu:unFig ] Games ] Media ]

Lagin ad m
Mame
Pricing Standard
Payrent Pre-paid
£ Top-up... Pre-paid 50.00
Order. .. Time 0:01 0.03 Call of Dukyd
TrafFic 0
Chat.., Others 0
Sum 0.03
ﬂ Password. .. Tax 0

8 Log OFF Total 0.03
Balance 49. 97

time left: 25:00

Create Steam Game Shortcut

If you don't want to let your customers select a game from the list, you can use the applaunch Steam
parameter in your Application > Path field to run a game directly. For example, use the following
command to run Counter-Strike:

Steam.exe -applaunch 10
Read more on the Steam command-line parameters on the following page:

http://developer.valvesoftware.com/wiki/Steam Command_Line Options

...and get the list of Steam application IDs here:

http://developer.valvesoftware.com/wiki/Steam_Application_IDs



http://developer.valvesoftware.com/wiki/Steam_Command_Line_Options
http://developer.valvesoftware.com/wiki/Steam_Application_IDs

Bandwidth Management

You can specify some Internet bandwidth usage limit for every customer terminal. Depending on a
pricing package, a bandwidth limit can be 64, 96, 128, etc. kbps or unlimited.

Bandwidth limit > Download bandwidth + Upload bandwidth

Requirements

In order to guarantee that the bandwidth management feature actually handles all your terminal
connections, you have to setup TrueCafe Server on your Internet gateway computer

Unfortunately, bandwidth management won't work for thin clients such as NComputing, Windows
Terminal Server, etc., since they share the same host IP address.

Setup

1. Open your pricing settings: ' main menu > Setup > Pricing and set bandwidth limit for your pricing
packages.

2. Activate the bandwidth management system: | main menu > Tools > Internet... > Bandwidth
management

« [nternet, URL, Wi-Fi

B(=)ES

Select a network adapker which connects wour server computer
ko yiour cuskomer kerminals:

= Pricing
Service packages |
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D i fil 100
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Game Console Billing
(XBox, Nintendo, Sony PlayStation)

TrueCafe supports billing of game consoles such as XBox, Nintendo, Sony PlayStation, etc.

The idea is to use X10 power devices such as Insteon or Easy PC Control. You install and connect
such devices to your power line. Then you plug in your game console monitors to the X10 modules. You
can turn on/off any X10 module from your server, which means a game console monitor turns on when
a customer session is started and turns off when the session is stopped.

You can read more on X10 here:

X10 industry standard

Insteon

1. Install X10 modules

Setup X10 system in your cafe, plug in your game consoles monitors. Install X10 drivers on the server
computer. Make sure that you can turn on/off any X10 (which means a console monitor) from the

server.


http://en.wikipedia.org/wiki/X10_(industry_standard)
http://en.wikipedia.org/wiki/INSTEON

2. Add game consoles to TrueCafe

Open TrueCafe main menu > Setup > Terminals . Add your game consoles to the list specifying X10
devices addresses (A1, A2, etc.) in the IP address field:



Terminal

X)

General |Extrs | Wirtual |

Marme |x350-1 | @

Compuker narme | |

{if differs from the name above)

| (%) Static |-°-1 |

{:} Crnarnic

MaC | |

I Ok l [ Cancel

« lerminals E E| f5__<|

Terminals | Profiles |

[ [ Mew... ][ & Edi... ][ 32 Delete ]

Marme ICumputer name |IP address IPru:uFiIe |Llser nae IState | e
| Adrmin W51 127.0.0.1 Game Skakion Enabled

arme Skakion Enabled
 [Enabled |

(o profile) Enabled

(o profile) Enabled

%360-1

I1E:4

[[] add terminals with TrueCafe Client installed autamatically

Close

3. Specify turn on/off commands

Open TrueCafe main menu > Tools > Options > Script tab . Specify turn on/off scripts:
"C:\Program Files\AHSDK\bin\ahcmd.exe" sendrf terminal_ip_address on

"C:\Program Files\AHSDK\bin\ahcmd.exe" sendrf terminal_ip_address off



Options

| zeneral | Design | Buttons | TrueCafe Client | Security | Tickets | CO-keys | kKeyboard | Scripts

TrueCafe Client. Log on

TrueCafe Client, Log off

Server, Terminal, Log on

|"C:'|,Pr|:|gram FilestaH30K bin ahcrnd . exe” sendrf terminal_ip_address on |

Server, Terminal. Log off
|"C:'|,Pru:ugram Files\aH3DK bintahcrnd . exe” sendrf terminal_ip_address off |

| @b | | ok | | concel

How this works

When you start a customer session on a game console icon on the server, TrueCafe replaces the
terminal_ip_address command param with your X10 device address and runs e.g. the following
command:

"C:\Program Files\AHSDK\bin\ahcmd.exe" sendrf A1 on
...which turns on the corresponding game console monitor.

Similarly, when you stop a session, the "turn off" command is executed.



Advertisement

Display advertisement on your terminals on the TrueCafe Client background. An advertisement can be a

web page or picture, e.g:

C:\temp\picturel.jpg (local path on the terminal computer)

http://www.website.com (don't forget to specify http://)

Use TrueCafe main menu > Setup > Advertisement to configure the ad list and display interval.

Rates:

10 minutes =

20 minutes =

60 minutes

S« myCafe

$0.50
$0.80
$2.00

TrueCafe 4.6.1102.21 DEMO. Logon (Serge)

Login |
Password |
Language |Engli5h j
Options == ‘ Enter ‘
Advertisement
[¥] Enabled
Period 0 & sec

The list of web pages to display on the TrueCafe Client background

http:/fwww. truecafe.net/downloadfad/ad_sample. html
[imy_server fimages/ad1.jpeq




Database Cleanup

Use the database cleanup to delete unused print log, CD-key reservation log or URL log records.

Delete inactive customers doesn't delete system customers such as annonymous or administrator. It
doesn't also delete your cyber cafe operators.

Clear all sales data irrevocably deletes unused customers, sales, customer sessions, top-ups and

shifts. Use this option in order to optimize your database.

This feature is only available for an administrative user.

[ ]clear print log

[ ]clear CO-key reservations

[ ]clear URL log

[ ] Delete inactive customers and kickets
[ ]clear receipts

[ ]clear all sales data

Upto 21082008 v |

’ E?}Help ] I K l ’ Cancel




Language Editor

TrueCafe interface supports unlimited number of languages. You can translate TrueCafe into your own
language.

TrueCafe stores language settings in the .tcl files (eng.tcl for English, ger.tcl for German, etc.), that are
located in the lang subfolder. Those are text files that contain "key = value" pairs. You can easily edit
the language files in any text editor.

Moremover, TrueCafe provides an integrated tool called Language Editor. It help you directly edit the
language settings from the running program. Press Ctrl-F11 in either TrueCafe Administrator, Report or
Client on any window to open the Language Editor. By default, Language Editor displays the text
messages from the last active window, but you can switch it to the "show everything" mode. Edit the
text and press "OK" to save the changes or "Cancel" to discard them.

Language Editor E|
Language Texk conkained
English (%3 0n the last active window
1 Arywhere
seckion pararm value -
main man Management
main toals Taols)
main help Help
client skation Workstations
servicelist | caption Pricing
main options Options
main ok, Lok,
main ackion Ackions
abouk caption Abiouk
main exik Exik
main reporks Reporks
main servermanac|Server Manager
PR add Rlau M
(] 4 l ’ Cancel




Database Workshop

Use Database Workshop to update the TrueCafe database or make system backup/restore.

Before making backup/restore it is recommended to stop all TrueCafe applications and server,
excluding TrueCafe Client. Backups are stored in the backup folder of TrueCafe data directory.

% TrueCafe Database Workshop |ZHE|F>__<|

Update |; Bac

%ﬁ Claze TrueCafe, Repaorts, stop TrueCafe Server

= hefore backuping or restaring the zustem.

Server Manager

Dratetime

01,/04,/2006 5:11:57 P
01,/03/2006 5:11:57 P
01/02/2006 5:11:57 Pk
12/5/2008 5:11:57 PM

Backup schedule

Select the days of week and set the time when you want TrueCafe to make a backup of your database

and settings automatically.



1" TrueCafe Database Workshop

Ry-

S pecify when you want to backup system fles
automatically. Restart Server to apply changes.

Server Manager

[ 5unday

b onday
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“Wednesday
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Friday
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22:00
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18:00
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How to...
General

How to contact TrueCafe team
How to purchase TrueCafe

Installation

How to setup TrueCafe
How to setup Wi-Fi billing

Client

How to lock a terminal

How to set server ip-address

How to set a background picture
How to utilize a dial-up connection (GPRS, etc.)

Terminals

How to setup TrueCafe on NComputing or Terminal Server platforms

How to arrange terminals

How to shutdown or restart a terminal

How to start an application on a terminal
How to disable TaskManger, hide Windows Desktop items, etc. on a terminal

How to configure the list of applications which a user can start on a terminal

Pricing

How to setup distinct pricing for each group of customers
How to setup a particular pricing

How to setup a terminal-dependent pricing
How to get pricing setup examples

How to set a default pricing for a customer
How to provide discounts

Customers

How to configure a customer account

How to top-up a customer balance

How to promote an account
How to configure user access

How to configure the list of programs a customer may start
How to scan customer's documents

Tickets

How to utilize pre-paid tickets (time codes




How to distribute tickets among your agents/employees
How to create tickets

How to print tickets

How to sell tickets online

How to sell tickets offline

How to log in using a ticket
How to use a ticket to top-up a customer balance

How to delete and recover tickets
How to create tickets for only Wi-Fi or desktop terminals

Sessions

How to use pre-paid and post-paid sessions

How to start a session from a terminal

How to start a session from the server

How to monitor customer sessions

How to sell a product (drink, snack, etc.) during a session
How to stop a session from a terminal

How to stop a session from the server

How to close a session

How to pause/resume a session

How to make a refund

How to chat with a customer

Internet

How to calculate session Internet traffic/bandwidth
How to limit your terminals Internet bandwidth

Wi-Fi billing

How to add wi-fi billing exceptions so that some websites or terminals aren't blocked (white list)

Games

How to use license key management system

How to setup Valve Steam support

Print monitoring

How to automatically charge customers for printing
How to notify a customer about pages/charge information
How to block printing if not enough money left on a customer balance

Point of sale

How to make a walk-in (guest customer) sale
How to make a member sale

How to customize a receipt
How to control item available amount in the stock

How to use a barcode scanner to sale items



Power management

How shutdown idle or all terminals
How shutdown an idle terminal automaticall

How turn on a terminal remotel

Backup

How to backup/restore TrueCafe database and system files

How to configure a backup schedule

Others

How to briefly view your cyber cafe daily activity and financial data

How to analyze your business data

How to use Web Reports

How to get reports by email

How to sell tickets and top-up customer accounts remotely from your web browser

How to clean up the database
How to translate TrueCafe into your own language




Internet Gateway

In order to provide wireless billing, calculate traffic or enable URL log or bandwidth management
features, you have to install TrueCafe Server on your Internet gateway computer (Microsoft Windows is
only supported). The gateway handles all network connections from your customer terminals.

wired terminals
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Intenet gateway
TrueCafe Server

We recommend the following approach... There are 2 network cards (NICs) in your Internet gateway
computer - NIC1 and NIC2. NIC1 is connected to the Internet (WAN) via xXDSL/ADSL, Cable, etc. NIC2
is connected to your LAN: Wi-Fi access point, hub, switch, etc.

Use Windows Internet Connection Sharing feature in order to make a bridge between NIC1 and NIC2.

You can use direct Internet connections or proxy 8080 connections as well.

Setup

Setup Internet Connection Sharing between the network cards on your Internet gateway (server)
computer. Your WAN-connected network card (NIC1) has IP address usually provided by your Internet
Service Provider. Your LAN-connected network card (NIC2) obtains some internal IP address, most
often 192.168.0.1.

Read more about how to setup Internet Connection Sharing

Your Wi-Fi access point uses DHCP to assign a dynamic IP to a customer's wireless laptop when it's
connected. Access point gateway IP setting is your NIC2 IP address (192.168.0.1).

Please make sure that you have your wi-fi router NAT feature disabled. Otherwise all your wi-fi
terminals IP addresses are translated into the single router IP address on the server side.

If you use a router in your LAN, it's gateway has to be your NIC2 IP address as well (192.168.0.1).


http://support.microsoft.com/kb/234815
http://support.microsoft.com/kb/306126
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Step-by-step Wireless Billing Setup

Introduction

This article demonstrates how to setup a very simple Wi-Fi billing approach. You need the following
hardware:

1. A server computer which is connected to the Internet (e.g. via ADSL modem).
2. An extra LAN (Ethernet) card.
3. Wireless router (Linksys WRT54G, D-Link DIR-300, etc.)

The idea is to make your server computer your Internet gateway computer, which means the computer

with TrueCafe Server installed is located between your ADSL router and Wi-Fi router:

1. Plug in extra Ethernet card

Plug in your extra Ethernet card into your server PCI slot and let Windows detects the card and install
the corresponding network card driver.

In this example Local Area Connection 1 (NIC1) is a primary card connected to the ADSL modem
and Local Area Connection 2 (NIC2) is an extra network card:

*s Network Connections

File Edit ‘iew Favorites Tools  Advanced Help



¢) J - ¥ | P search Folders | [ (3 X ) | [T~

Address ‘i:; Mebwork Connections

Mame Tvpe Skatus
LAM or High-5Speed Internet

L Local Area Connection 1 LAMN or High-Speed Internet Connecked
L Local Area Connection 2 LAMN or High-Speed Internet Metwark cable unplugged

2. Enable Internet Connection Sharing

Open your NIC1 properties and enable Internet Connection Sharing. If you have more than 2 cards

enabled, you have to select your NIC2 in the list:

-+ Local Area Connection 1 Properties

General Advanced

‘Windows Firewal

Protect my computer and nebwork, by limiting Settings
or preventing access to this computer fram =
the [nternet

Intermet Connection Sharing

Allow other netwark, uzers to connect thraugh this
compLter's [ntermet connection

Home networking connechon:

| cal Area Con w |

[ ] Allows other network uzers to control or disable the
shared |nternet connection

Learn more about Internet Connection Settings
Sharing.

If you're not sure how to zet these properties, use
the Metwork Setup Wizard instead.

(1] ] [ Cancel

Open your NIC2 properties and change default IP address and subnet mask to
IP address = 192.168.0.2

Subnet mask = 255.255.0.0



Internet Protocol (TCP/IP) Properties

General

You can get P settings assigned automatically if your network. supports
thiz capability. Othenwise, you need to ask your network, administrataor for
the appropriate P zettings.

(T Obtain an IP address autamaticallp
() Uze the following IP address:

IP address: 192.168. 0 . 2 |

Subnet mask: | 255 .255. 0 . 0 |

Default gateway: | . . . |

Obtain DMS zerver addrezs automatically

(%) Use the following DNS server addresses:

Prefered DMS zerver | . . . |

alternate DMS server | . . . |

I Ok ][ Cancel ]

2.A. What if you don’'t like Internet

Connection Sharing

If you think that Internet Connection Sharing is not OK for you, you could try some other alternative

Windows routing software. We recommend using NAT32 since many our clients use it and it proves to

work well with TrueCafe.

3. Setup Wi-Fi router

Connect your NIC2 with a cable to your router LAN port (not Internet port):


http://www.nat32.com/

Set the router IP address = 192.168.0.3. Switch the router into Access Point mode. Disable router
DHCP.

Read more on how to setup your router model:

Linksys router setup (WRT54GL)

D-Link router setup (DIR-300)

4. Connect Wi-Fi laptop

Connect your Wi-Fi laptop to your wireless network and make sure that you can surf the web.

5. Setup TrueCafe Server

Install TrueCafe on your server computer.

Open TrueCafe main menu > Tools > Internet... , select your NIC2 and enable the Wi-Fi billing
option:



Internet, URL, Wi-Fi

Select a network adapter which connects your server computer
to wour cuskomer terminals:

Adapter Local Area Connection 2 (
Traffic

[ ]incoming traffic

[ ]oubgoing traffic

[ ]Bandwidth management
LRL log

CIURL lag
Exclude |.I:ump .gif .jpg .jpeg .png .j5 .cs5 .ico
Wi-Fi

Wi-Fi billing
Timeouk min
‘white lisk

’ {(Z) Help ] I O l [ Cancel

6. Login Wi-Fi laptop

Try opening any website from your Wi-Fi laptop and get TrueCafe login page. Type your customer/ticket
login/password to start a session and continue browsing the web. Try login/password = test/test by
default.



& TrueCafe Login - Windows Internet Explorer

(o] O =]

O O = |@ http:/fwww.t.. v| B |4’,’_| x ‘ |E) Bing 2o
i Favorites ‘@ Trueafe Login |—| M- > [ ”
ot
g
S¢  myCafe
Login  test
Password eeese
Lﬂgin
&) Internet | Protected Mode: Off fy v EH100% -




‘& TrueCafe Info - Windows Internet Explorer EI -‘
@Q v |&] htp/1921.. ~| & |4 | X || 8ing o~

'S',:? Favorites ETrueCafeInfo ﬁ v > =

Please wait 3 seconds while the
connection is being activated.

Type GATE in your browser address bar
to see your session info.

Open www.truecafe.net/

Login test
Pre-paid 5.00

Time 0:00
Traffic
Others

Sum
Tax

o o o o o o

Total
Balance 5.00

Time left: 0:31

‘ Refresh ‘ ‘ Log Off

& Internet | Protected Mode: Off ¥ v HI00% -




Setup D-Link DIR-300 Wi-Fi Router

Login to your router control panel. Open ' Setup > LAN Setup , change your router IP address if needed
and disable DHCP server:

»1.03

SETUP | ADYANCED MAINTENAMNCE STATUS “

Lse this section to configure the internal network settings of your router and also to configure

the built-in DHCP server to assign IP address to the computers on your network, The IP address
Time and Date that is configured here is the IP address that vou use to access the web-based managernent
e | interface, If vou change the IP address here, you may need to adjust your PC's network settings
Parent: tro to access the network again,

Please note that this section is optional and you do not need to change any of the
settings here to get your network up and running.

CFfline [ Save Settings ] [ Don't Save Settings ]

ROUTER. SETTINGS

IJse this section to configure the internal network settings of your router, The IP address that is
configured here is the IP address that you use to access the web-based management interface,
If you change the IP address here, you may need to adjust your PC's netwaork settings to access
the netwiork again.

Router IP Address : |192.168.0.3 |

Default Subnet Mask @ |255.255.255.0 |

Lacal Domain Mame © | |
Enable DNS Relay

DHCP SERVER SETTINGS

I s this section to configure the built-in DHCP server to assion IP address to the computers on
your network,

Enable DHCP Server ;. [
DHCP IP Address Range to [addresses within the LAM subnet)
DHCP Lease Time {rninutes)

DHCP CLIENT LIST

Host Marne IP &ddress MAC Address Expired Time

The Internet options Setup > Internet Setup remain default:



Product Page : DIR-300 Firrrvare Yersion ; 1.03

sl

M| SETUP | ADYAMNCED MAINTEMANCE S5TATUS HELP

Helpful Hints..

Internet Setup

Wi tp - Intern_el: Conneckion:

Ilse this section to configure your Internet Connection type, There are several connection types e
LAN Setup to choose from: Static IP, DHCP, PPPoE, PPTR, L2TP, and BigPond, If you are unsure of your iy )

- connection method, please contact your Internet Service Provider.
Time and Date
MNote: If using the PPPoE option, you will need to rermove or disable any PPPOE diett software
oR YOoLE COMmpUters,

[ Save Seftings ][ Don't Save Sefttings ]

ACCESS POINT MODE

U=z this to disable NAT on the router and turn it into an Access Point,

[JEnable Access Point Mode

INTERNET CONNECTION TYPE

Choose the rmode to be used by the router to connect to the Internet,

My Internet Connection is ; |Dvnamic IP (DHCP) v|

DYNAMIC IP (DHCP) INTERNET CONNECTION TYPE

Ise this Internet connection type if your Internet Service Provider (I15P) didn't provide you with
IP Address information andfor a username and passwaord,

Host Marne |DIR-3|JI:| |

MAC Sddress | - - - | - - |
(optional) [ Clone MaC Address ]

Prirnary DMS Address . |:|
Secondary DMNS Address :l {optional)

[ Sawve Settings ] [ Don't Save Settings ]




Setup Linksys WRT54GL Wi-Fi Router

Login to your router control panel. Open Setup > Basic Setup , change your router IP address if
needed and disable DHCP server:

LINKSYS®

A Division of Cisco Systems, Inc.

Wireless-G Broadband Router

Setup '
Security Restrictions

Internet Setup

Internet Connection Type

‘ Automatic Configuration - DHCF |+ |

Optional Settings

(required by some I5Ps) |WRT54GL |

Hast Mame: | |

Rauter Mame:

Damain Mame: | |

Size: IW

Network Setup

Router IP Local P Address:  [192| |168| (0 |3 |
Subnet Mask: | 255.255.255.0 |
Hetwork Address DHCR Server: (JEnable (%) Disable

Server Settings (DHCP)

Starting P
P 192.168.0.| L (1)
hdaximum Mumber of =
DHCP Uzers:
Cliert Lesse Time: ID minutes (0 means ane day)
Static DNS 1: o Jo o Jo o
Static DNS 2 jo = Joo joo o
Static DNS 3: jo - Jo jor o
WINS: for - Jor o for o
Time Setting Time Fone:
| (G T-08:00) Pacific Tirme (IUSA & Canada) hd

Avtomatically adjust clock for davlight saving changes

Open Setup > Advanced routing and set Operating mode = Gateway:

LINKSYS®

A Division of Cisco Systems, Inc.

Wireless-G Broadband Router

Firmuware &

WRTS54GL

Administratio Status

zed] Routing

Local IP Address : Tl
addresz of the router.

Subnet Mask : Thi the
subnet m of the router.

Wau may limit the
f oK

Cisco SYSTEMS

Firmware &

WRT54GL
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DD | hA

Administration Status

Security

Advanced Routing

Static Routing Select set number: [ Delete This Entry

Erter Route Mame: | |

Destination LanP: [0 [[0 [0 |0 |

Subnet Mask: o Lo |lo [lo |

Default Gatesway: |D ||E| ||EI ||EI |

Interface: | LAM & Wireless v |

Show Routing Table ]

Subnet Mask
nicl the ne
More...
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Step-by-step Wireless Billing Setup
on Windows 7
Introduction

This article demonstrates how to setup a very simple Wi-Fi billing approach. You need the following
hardware:

1. A server computer which is connected to the Internet (e.g. via ADSL modem).
2. An extra LAN (Ethernet) card.
3. Wireless router (Linksys WRT54G, D-Link DIR-300, etc.)

The idea is to make your server computer your Internet gateway computer, which means the computer

with TrueCafe Server installed is located between your ADSL router and Wi-Fi router:

1. Plug in extra Ethernet card

Plug in your extra Ethernet card into your server PCI slot and let Windows detects the card and install
the corresponding network card driver.

In this example Local Area Connection 1 (NIC1) is a primary card connected to the ADSL modem
and Local Area Connection 2 (NIC2) is an extra network card:

Windows Control Panel > Network and Internet > Network and Sharing Center > Change adapter
settings (on the left)



Organize = Disable this network device Diagnose this connection =

Mame Status Device Mame Connectivity Metwork Category

@ Local Area Connection 1 Metwork, Shared D-Link DFE-520... Internet access Private network
l [H] Local Area Connection 2 Unidentified network  MVIDIA nForce ..  Molnternetaccess  Public network

2. Enable Internet Connection Sharing

Open your NIC1 properties and enable Internet Connection Sharing.



—
U Local Area Connection 1 Properties

Shamng

Intemet Connection Sharing

T

[¥]:Allow other network users to connect through this |
computers Intemet connection

Allow other network users to control or disable the
shared Intemet connection

Using ICS {Imtemet Connection Sharing) Seftings.

ok || Ccancel

Windows setup the following NIC2 properties:
IP address = 192.168.137.1
Subnet mask = 255.255.255.0

You should not change these values because Internet Connection Sharing may stop working.

2.A. What if you don’'t like Internet
Connection Sharing

If you think that Internet Connection Sharing is not OK for you, you could try some other alternative
Windows routing software. We recommend using NAT32 since many our clients use it and it proves to

work well with TrueCafe.

3. Setup Wi-Fi router

Connect your NIC2 with a cable to your router LAN port (not Internet port):


http://www.nat32.com/

Set the router IP address = 192.168.0.3. Switch the router into Access Point mode. Disable router
DHCP.

Read more on how to setup your router model:

Linksys router setup (WRT54GL)

D-Link router setup (DIR-300)

4. Connect Wi-Fi laptop

Connect your Wi-Fi laptop to your wireless network and make sure that you can surf the web.

5. Setup TrueCafe Server

Install TrueCafe on your server computer.

Open TrueCafe main menu > Tools > Internet... , select your NIC2 and enable the Wi-Fi billing
option:



Internet, URL, Wi-Fi

Select a network adapter which connects your server computer
to wour cuskomer terminals:

Adapter Local Area Connection 2 (
Traffic

[ ]incoming traffic

[ ]oubgoing traffic

[ ]Bandwidth management
LRL log

CIURL lag
Exclude |.I:ump .gif .jpg .jpeg .png .j5 .cs5 .ico
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’ {(Z) Help ] I O l [ Cancel

6. Login Wi-Fi laptop

Try opening any website from your Wi-Fi laptop and get TrueCafe login page. Type your customer/ticket
login/password to start a session and continue browsing the web. Try login/password = test/test by
default.



& TrueCafe Login - Windows Internet Explorer

(o] O =]
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‘& TrueCafe Info - Windows Internet Explorer EI -‘
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Please wait 3 seconds while the
connection is being activated.

Type GATE in your browser address bar
to see your session info.

Open www.truecafe.net/

Login test
Pre-paid 5.00

Time 0:00
Traffic
Others

Sum
Tax

o o o o o o

Total
Balance 5.00

Time left: 0:31

‘ Refresh ‘ ‘ Log Off

& Internet | Protected Mode: Off ¥ v HI00% -
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